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Send Us Your Comments
Oracle Transportation Management Installation Guide, Release 6.2
Part No. E20094-08

Oracle welcomes your comments and suggestions on the quality and usefulness of this publication.
Your input is an important part of the information used for revision.

Did you find any errors?

e Is the information clearly presented?

e Do you need more information? If so, where?

e Are the examples correct? Do you need more examples?
e What features did you like most about this manual?

If you find any errors or have any other suggestions for improvement, please indicate the title and
part number of the documentation and the chapter, section, and page number (if available). You can
send comments to us in the following ways:

e Electronic mail: otm-doc_us@oracle.com

If you would like a reply, please give your name, address, telephone number, and electronic mail
address (optional).

If you have problems with the software, contact Support at https://support.oracle.com or find the
Support phone number for your region at http://www.oracle.com/support/contact.html.
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Preface

This manual is for administrators who are responsible for installing the Oracle Transportation
Management system at your site. This manual provides step-by-step installation instructions for
installing all Oracle Transportation Management software components. This manual does not cover the
installation of any operating system that is required to run Oracle Transportation Management such as
Linux or Windows Server. It is assumed that your IT staff will handle the installation and configuration
of this software.

Change History

Date

Document Revision

Summary of Changes

12/10

-01

Initial Release.
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-02
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1. Installation Requirements

Windows 2008 Server Installation Requirements

It is HIGHLY recommended that you make available personnel who are familiar with the installation
and configuration of Windows-based applications. It is also recommended that you have an
administrator familiar with the creation and support of Oracle Database instances. A Network
Administrator may be necessary at times, especially during the configuration of systems that will be
accessed through firewalls, VPN, etc.

You must be logged in as Administrator or someone with Administrative privileges to install Oracle
Transportation Management successfully.

Minimum Hardware Requirements

Note: This section only details the minimum hardware required to run the base Oracle
Transportation Management application. It does not take into account additional Oracle
Transportation Management components or third-party components and it is not a
configuration for high volume or complex implementations. To determine the correct
configuration for your production, test, and development environments, you should work
with your hardware and/or implementation consultants.

Web User

You must have a computer capable of running one of the supported browsers (see the Oracle
Transportation Management Technical Architecture document for a list of supported browsers). Many
factors will affect the performance experience of the end-user, including: CPU type & speed; operating
system version; available memory; hard drive speed; network card speed, and network bandwidth
between the browser and the web server.

Note: Popup Blockers may prevent your browser from working correctly with Oracle
Transportation Management. If you experience any problems, try disabling them before
contacting Technical Support.

Note: If you want to view the results generated by the Load Configuration feature, a VRML
plug-in for your Web Browser is needed. Oracle Transportation Management has been
tested with the Cortona plug-in for Internet Explorer, available at:
http://www.parallelgraphics.com/products/cortona/.

Test and Development Servers

e Combined Web & App: 2 x 3.0 GHz dual-core Xeon CPU, 6 GB RAM, 40 GB disk
Note: For the database server, please see the documentation associated with that product.

Production Servers

e Web Server: 2 x 2.5 GHz quad-core Xeon CPU w/ 18 MB cache, 6 GB RAM, 80 GB disk
e Application Server: 2 x 2.5 GHz quad-core Xeon CPU w/ 18 MB cache, 8 GB RAM, 80 GB disk
Note: For the database server, please see the documentation associated with that product.

Software Requirements for Oracle Transportation Management Server
Configurations

e 64-bit Windows Server 2008 R2 Enterprise x64 Edition with the latest Service Packs, OR

Copyright © 2001, 2012, Oracle and/or its affiliates. All rights reserved. 11



e 64-bit Windows Server 2008 Standard Edition with the latest Service Packs
e Oracle 11gR2 (11.2.x) Database Enterprise Edition

e Oracle WebLogic Server Standard Edition 11gR1 (10.3.3.x)

e Integration Server - EAI solution (optional)

The following software is distributed with Oracle Transportation Management:

e Apache Web Server 2.2.16

e Tomcat Java Servlet Server 6.0.18

e OpenSSL 0.9.80

e Zlib1.2.3

e 64-bit JRockit JDK 1.6.0_20 (R28.0.1)
e Python 2.4.2

The Oracle Transportation Management software is distributed on DVD or via download from standard
Oracle channels.

Preparing to Install Oracle Transportation Management

Before you begin the installation process, ensure that the following is already complete:

e A compatible operating system is installed (see above).

e The “Server” service under the “Network” Control Panel (Start Menu -> Settings -> Control
Panel) is set to “"Maximize Throughput for Network Applications”.

e Virtual memory is set to 1.5 to 2 times the amount of physical memory in the system. Also,
within the “Server” control panel (Performance) set the “Performance boost for the foreground
application” to NONE.

e All Oracle Transportation Management server machines are time-synced using a process like
NTP. This is critical to the proper operation and troubleshooting of an Oracle Transportation
Management instance.

e Oracle 11gR2 (11.2.x) Database client (Administrator install) has been installed and
configured to connect to your database.

Installing WebLogic on the Application Server

Install WebLogic Server version 11g as per the accompanying documentation. Note the BEA Home
directory (e.g. D:\product\bea) and the WL Home directory (e.g. D:\product\bea\weblogicl1g).

Note: The user that Oracle Transportation Management runs as must have read access to
the Weblogic install directory and all of its sub-directories.

Installing Oracle Transportation Management
Follow the instructions in the Installing Oracle Transportation Management chapter to finish your

Oracle Transportation Management installation. You must be logged in as Administrator or someone
with Administrative privileges to install Oracle Transportation Management successfully.

Solaris Installation Requirements

It is HIGHLY recommended that you make available personnel who are familiar with the installation
and configuration of UNIX based applications. Also, it is recommended that you have an administrator
familiar with the creation and support of Oracle Database instances. A Network Administrator may be

1-2 Copyright © 2001, 2012, Oracle and/or its affiliates. All rights reserved.



necessary at times, especially during the configuration of systems that will be accessed through
firewalls, VPN, etc.

You must run the installer as a non-root user, though root access will be required to run a script
during the installation. The user that runs the installer must have full rights to the installation
directory.

Minimum Hardware Requirements

Note: This section only details the minimum hardware required to run the base Oracle
Transportation Management application. It does not take into account additional Oracle
Transportation Management components or third-party components and it is not a
configuration for high volume or complex implementations. To determine the correct
configuration for your production, test, and development environments, you should work
with your hardware and/or implementation consultants.

Web User

You must have a computer capable of running one of the supported browsers (see the Oracle
Transportation Management Technical Architecture Guide for a list of supported browsers). Many
factors will affect the performance experience of the end-user, including: CPU type & speed; operating
system version; available memory; hard drive speed; network card speed and network bandwidth
between the browser and the web server.

Note: Popup Blockers may prevent your browser from working correctly with Oracle
Transportation Management. If you experience any problems, try disabling them before
contacting Technical Support.

Note: If you want to view the results generated by the Load Configuration feature, a VRML
plug-in for your Web Browser is needed. Oracle Transportation Management has been tested
with the Cortona plug-in for Internet Explorer, available at:
http://www.parallelgraphics.com/products/cortona/.

Test and Development Servers

e Combined Web & App:1 x M3000 (2.75GHz quad-core SPARC64 VII processor), 6 GB RAM, 80
GB disk space

Note: For the database server, please see the documentation associated with that product.

Production Servers

e Web Server:1 x M3000 (2.75GHz quad-core SPARC64 VII processor), 4 GB RAM, 80 GB disk
space

e Application Server:1 x M3000 (2.75GHz quad-core SPARC64 VII processor), 8 GB RAM, 80 GB
disk space

Note: For the database server, please see the documentation associated with that product.

Software Requirements

e 64-bit Solaris 10 with the latest recommended patches

e Oracle 11gR2 (11.2.x) Database Enterprise Edition

e Oracle WebLogic Server Standard Edition 11gR1 (10.3.3.x)
e Integration Server - EAI solution (optional)

Copyright © 2001, 2012, Oracle and/or its affiliates. All rights reserved. 1-3



The following software is distributed with Oracle Transportation Management:

Apache Web Server 2.2.16

Tomcat Java Servlet Server 6.0.18

OpenSSL 0.9.80

Zlib 1.2.3

64-bit JRockit JDK 1.6.0_20 (R28.0.1)

Python 2.5.2 (version of Python is different from Windows 2.4.2 vs Solaris 2.5.2??)

The Oracle Transportation Management software is distributed on DVD or via download from standard
Oracle channels.

Preparing to Install Oracle Transportation Management

Before you begin the installation process, ensure that the following is complete:

A compatible operating system is installed (see above) along with any patch bundles
recommended by the OS vendor.

The size of the swap space on your server is equal to or greater than the amount of memory it
contains.

All Oracle Transportation Management servers are time-synced using a process like NTP. This
is critical to the proper operation and troubleshooting of an Oracle Transportation Management
instance.

Oracle 11gR2 (11.2.x) Database Client (Administrator install) has been installed and
configured to connect to your database.

Pre-Install Setup

Once the operating system is installed, you need to modify kernel parameters to ensure that Solaris
works properly with Oracle Transportation Management.

1. Edit the /etc/system file and add the following lines at the end of the file:
set rlim fd max=8192
set rlim fd cur=8192
set tcp:tcp _conn hash size=32768
set shmsys:shminfo shmmax 4294967295
set autoup 900
set tune t fsflushr 1
2. The following kernel parameters may improve your server’s performance. Your system
administrator should evaluate each of the settings below and add the appropriate settings to
your /etc/system file:
set maxpgio=25468
set slowscan=500
set ncsize=5000
set ufs ninode=10000
3. Update additional kernel parameters as needed for the Database Client. This is covered in the
Oracle Database installation documentation.
Restart the server.
5. Install the latest SUNWzlib or GNU zlib packages.
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Creating the Oracle Transportation Management User

’

You must add a group and user on the application server called ‘otm’.

Start the Admin tool.
Add a group called ‘otm’.

W N =

Add a user called ‘otm’ and set a password for the otm user.
4. Assign the otm user to the otm group.
Installing WebLogic on the Application Server

Install WebLogic Server version 11g as per the accompanying documentation. Note the BEA Home
directory (e.g. /opt/bea) and the WL Home directory (e.g. /opt/bea/weblogicl1g).

Note: The user that Oracle Transportation Management runs as must have read access to
the WebLogic install directory and all of its sub-directories.

Installing Oracle Transportation Management

Follow the instructions in the Installing Oracle Transportation Management chapter to finish your
Oracle Transportation Management installation. You must be logged in as Administrator or someone
with Administrative privileges to install Oracle Transportation Management successfully.

AlX Installation Requirements

It is HIGHLY recommended that you make available personnel who are familiar with the installation
and configuration of UNIX based applications. Also, it is recommended that you have an administrator
familiar with the creation and support of Oracle Database instances. A Network Administrator may be
necessary at times, especially during the configuration of systems that will be accessed through
firewalls, VPN, etc.

You must run the installer as a non-root user, though root access will be required to run a script
during the installation. The user that runs the installer must have full rights to the installation
directory.

Note: Sections that are specific to the type of application server being used are marked
with [WebLogic] or [WebSphere].

Minimum Hardware Requirements

Note: This section only details the minimum hardware required to run the base Oracle
Transportation Management application. It does not take into account additional Oracle
Transportation Management components or third-party components and it is not a
configuration for high volume or complex implementations. To determine the correct
configuration for your production, test, and development environments, you should work
with your hardware and/or implementation consultants.

Web User

You must have a computer capable of running one of the supported browsers (see the Oracle
Transportation Management Technical Architecture document for a list of supported browsers). Many
factors will affect the performance experience of the end-user, including: CPU type & speed; operating
system version; available memory; hard drive speed; network card speed and network bandwidth
between the browser and the web server.
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Note: Popup Blockers may prevent your browser from working correctly with Oracle
Transportation Management. If you experience any problems, try disabling them before
contacting Technical Support.

Note: If you want to view the results generated by the Load Configuration feature, a VRML
plug-in for your Web Browser is needed. Oracle Transportation Management has been tested
with the Cortona plug-in for Internet Explorer, available at:
http://www.parallelgraphics.com/products/cortona/.

Test and Development Server

¢ Combined Web & App: 2 x 1.9 GHz Power5+ CPU, 6 GB RAM, 80 GB disk
Note: For the database server, please see the documentation associated with that product.

Production Servers

e Web Server: 2 x 2.1 GHz Power5+ CPU, 4 GB RAM, 80 GB disk
e Application Server: 2 x 2.1 GHz Power5+ CPU, 8 GB RAM, 80 GB disk
Note: For the database server, please see the documentation associated with that product.

Software Requirements

e 64-bit AIX 6.1 with the latest recommended patches
e Oracle 11gR2 (11.2.x) Database Enterprise Edition
e [WebLogic] Oracle WeblLogic Server Standard Edition 11gR1 (10.3.3.x)

e [WebSphere] WebSphere Advanced Server 6.0 with the following patches (applied in the
following order) [application server only]:

o 6.0-WS-WAS-AixPPC32-RP0000002.tar
o 6.0.2-WS-WAS-AixPPC32-FP0000007.tar
o 6.0.2-WS-WASJavaSDK-AixPPC32-FP00000023.pak

Note: The WebSphere Application Server has not yet been certified with Oracle
Transportation Management 6.2; there is no ETA on when this will be completed.

e [WebSphere] WebSphere Application Client 6.0 [Web-only installs]
o Installer for this can be found in the AppClient directory of the main WAS install
e Integration Server - EAI solution (optional)
The following software is distributed with Oracle Transportation Management:

e Apache Web Server 2.2.16

e Tomcat Java Servlet Server 6.0.18
e OpenSSL 0.9.80

e Zlib1.2.3

e 64-bit IBM JDK 1.6.0 (SR8 FP1)

e Python 2.5.2

The Oracle Transportation Management software is distributed on DVD or via download from standard
Oracle channels.

Preparing to Install Oracle Transportation Management

Before you begin the installation process, ensure that the following is complete:
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e A compatible operating system is installed (see above) along with any patch bundles
recommended by the OS vendor.

e The size of the swap space on your server is equal to or greater than the amount of memory it
contains.

e All Oracle Transportation Management servers are time-synced using a process like NTP. This
is critical to the proper operation and troubleshooting of an Oracle Transportation Management
instance.

e Oracle 11gR2 (11.2.x) Database Client (Administrator install) has been installed and
configured to connect to your database.

Pre-Install Setup

Once the AIX operating system is installed, you need to modify kernel parameters to ensure that AIX
works properly with the application server.

1. Edit the /etc/security/limits file and change the following parameters:

fsize = -1
core = -1
cpu = -1
data = -1
rss = -1
stack = -1
nofiles = -1

2. Update additional kernel parameters as needed for the Database Client. This is covered in the
Oracle Database installation documentation.

3. Restart the server.
Creating the Oracle Transportation Management User

You must add a group and user on the application server called ‘otm’.

Start SMIT.
Add a group called ‘otm’.

w NP

Add a user called ‘otm’ and set a password for the otm user.
4. Assign the otm user to the otm group.
Installing WebLogic on the Application Server [WebLogic]

Install WebLogic Server version 11g as per the accompanying documentation. Note the BEA Home
directory (e.g. /opt/bea) and the WL Home directory (e.g. /opt/bea/weblogic911g).

Note: The user that Oracle Transportation Management runs as must have read access to
the Weblogic install directory and all of its sub-directories.

Installing WebSphere on the Application Server [WebSphere]

Note: WebSphere Application Server has not yet been certified with Oracle Transportation
Management 6.2; there is no ETA on when this will be completed.

You must purchase WebSphere version 6.0 from IBM. Once you have the appropriate license, you can
download the appropriate executables from the IBM website.

You must run this installer from an X display.

1. Uncompress and untar the was.6000.base.aix.tar.gz file.
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Launch WAS/install.

Accept the license agreement.

Install WebSphere into /opt/IBM/WebSphere/AppServer6.
Install your License file using the directions provided by IBM.

ISR L

Once base installation is complete, install the .tar patches one by one:

a. Uncompress the patch in the directory where WebSphere was installed to (e.g.
/opt/IBM/WebSphere/AppServer6); it will create a directory called ‘updateinstaller’.

b. Run the update script, e.g. /opt/IBM/WebSphere/AppServer6/updateinstaller/update.
c. Follow the on-screen directions.

d. When it is finished, run it again. Repeat until it tells you that there is nothing further
to install.

e. Remove the contents of the updateinstaller/maintenance directory.
f. Repeat with next .tar patch.
7. Once the .tar patches are installed, install the .pak patches one by one:

a. Copy the .pak file into the updateinstaller/maintenance directory (e.g.
/opt/IBM/WebSphere/AppServer6/updateinstaller/maintenance).

b. Run the update script, e.g. /opt/IBM/WebSphere/AppServer6/updateinstaller/update.
c. Follow the on-screen directions.

When it is finished, run it again. Repeat until it tells you that there is nothing further
to install.

e. Remove the contents of the updateinstaller/maintenance directory.
f. Repeat with next .pak patch.
Installing WebSphere AppClient on the Web Server [WebSphere]

Note: WebSphere Application Server has not yet been certified with Oracle Transportation
Management 6.2; there is no ETA on when this will be completed.

This only needs to be done for web-only servers. Servers where the Oracle Transportation
Management web & application pieces reside together should skip this step.

You must run this installer from an X display.

Uncompress and untar the was.6000.base.aix.tar.gz file.
Copy the AppClient directory to the target machine.

Run AppClient/install.

Accept the license agreement.

Install WebSphere into /opt/IBM/WebSphere/AppClient6.

6. Install your License file using the directions provided by IBM.

a bk wbdr-

Installing Oracle Transportation Management

Follow the instructions in the Installing Oracle Transportation Management chapter to finish your
Oracle Transportation Management installation. You must be logged in as Administrator or someone
with Administrative privileges to install Oracle Transportation Management successfully.

HP-UX Installation Requirements

It is HIGHLY recommended that you make available personnel who are familiar with the installation
and configuration of UNIX based applications. Also, it is recommended that you have an administrator
familiar with the creation and support of Oracle Database instances. A Network Administrator may be
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necessary at times, especially during the configuration of systems that will be accessed through
firewalls, VPN, etc.

You must run the installer as a non-root user, though root access will be required to run a script
during the installation. The user that runs the installer must have full rights to the installation
directory.

Minimum Hardware Requirements

Note: This section only details the minimum hardware required to run the base Oracle
Transportation Management application. It does not take into account additional Oracle
Transportation Management components or third-party components and it is not a
configuration for high volume or complex implementations. To determine the correct
configuration for your production, test and development environments you should work
with your hardware and/or implementation consultants.

Note: Oracle Transportation Management supports both PA-RISC and Itanium systems for
HP-UX. The machine specifications listed below are only for the currently available
architecture, Itanium. Please seek further RISC-platform guidance from your hardware
and/or implementation consultants.

Web User

You must have a computer capable of running one of the supported browsers (see the Oracle
Transportation Management Technical Architecture document for a list of supported browsers). Many
factors will affect the performance experience of the end-user, including: CPU type & speed; operating
system version; available memory; hard drive speed; network card speed and network bandwidth
between the browser and the web server.

Note: Popup Blockers may prevent your browser from working correctly with Oracle
Transportation Management. If you experience any problems, try disabling them before
contacting Technical Support.

Note: If you want to view the results generated by the Load Configuration feature, a VRML
plug-in for your Web Browser is needed. Oracle Transportation Management has been tested
with the Cortona plug-in for Internet Explorer, available at:
http://www.parallelgraphics.com/products/cortona/.

Test and Development Server

e Combined Web & App: 2 x 1.4 GHz dual-core Itanium CPU, 6 GB RAM, 80 GB disk
Note: For the database server, please see the documentation associated with that product.

Production Servers

e Web Server: 2 x 1.6 GHz dual-core Itanium CPU, 4 GB RAM, 80 GB disk
e Application Server: 2 x 1.6 GHz dual-core Itanium CPU, 8 GB RAM, 80 GB disk
Note: For the database server, please see the documentation associated with that product.

Software Requirements

e 64-bit HP-UX 11iv3 with the latest recommended patches
e Oracle 11gR2 (11.2.x) Database Enterprise Edition
e Integration Server - EAI solution (optional)
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e Oracle WebLogic Server Standard Edition 11gR1 (10.3.3.x)

The following software is distributed with Oracle Transportation Management:

e Apache Web Server 2.2.16

e Tomcat Java Servlet Server 6.0.18
e OpenSSL 0.9.80

e Zlib1.2.3

e 64-bit HP JDK 1.6.0.07

e Python 2.5.2

The Oracle Transportation Management software is distributed on DVD or via download from standard
Oracle channels.

Preparing to Install Oracle Transportation Management
Before you begin the installation process, ensure that the following is complete:

e A compatible operating system is installed (see above) along with any patch bundles
recommended by the OS vendor.

e The size of the swap space on your server is equal to or greater than the amount of memory it
contains.

e All Oracle Transportation Management servers are time-synced using a process like NTP. This
is critical to the proper operation and troubleshooting of an Oracle Transportation Management
instance.

e Oracle 11gR2 (11.2.x) Database Client (Administrator install) has been installed and
configured to connect to your database.

Pre-Install Setup

Once the HP-UX operating system is installed, you need to modify kernel parameters to ensure that
HP-UX works properly with Oracle Transportation Management.

1. Use SAM to update the following kernel parameters. These are minimum settings and may be
higher:
maxusers=400
max threads proc=<maxusers>*3
maxfiles=8192
maxfiles 1im=8192
ncallout=2* ((((nproc*7)/4)+16)*2)
nkthread=2*<max thread proc>
nfile=(2*<nproc>)+1000
nproc= (<maxusers>*5) +64

2. Update additional kernel parameters as needed for the Database Client. This is covered in the
Oracle Database installation documentation.

3. Restart the server.
Creating the Oracle Transportation Management User

You must add a group and user on the application server, e.g. ‘otm’ or ‘otm62’.

1. Start SAM.
2. Add a group called ‘otm’.
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3. Add a user called ‘otm’ and set a password for the otm user.
4. Assign the otm user to the otm group.
Installing WebLogic on the Application Server

Install WebLogic Server version 11g as per the accompanying documentation. Please note the BEA
Home directory (e.g. /app/bea) and the WL Home directory (e.g. /app/bea/weblogicl1g).

Note: The user that Oracle Transportation Management runs as must have read access to
the WeblLogic install directory and all of its sub-directories.

Installing Oracle Transportation Management

Follow the instructions in the Installing Oracle Transportation Management chapter to finish your
Oracle Transportation Management installation. You must be logged in as Administrator or someone
with Administrative privileges to install Oracle Transportation Management successfully.

Oracle Enterprise Linux Installation Requirements

It is HIGHLY recommended that you make available personnel who are familiar with the installation
and configuration of UNIX based applications. Also, it is recommended that you have an administrator
familiar with the creation and support of Oracle Database instances. A Network Administrator may be
necessary at times, especially during the configuration of systems that will be accessed through
firewalls, VPN, etc.

You must run the installer as a non-root user, though root access will be required to run a script
during the installation. The user that runs the installer must have full rights to the installation
directory.

Red Hat Linux

Red Hat AS/ES 5 is also a supported platform, but Oracle Transportation Management has not been
certified on it. In this manual, wherever Oracle Enterprise Linux Server release 5.1 is referenced,
simply replace it with Red Hat AS/ES 5. Any Red Hat-only instructions will be clearly marked as such.

Minimum Hardware Requirements

Note: This section only details the minimum hardware required to run the base Oracle
Transportation Management application. It does not take into account additional Oracle
Transportation Management components or third-party components and it is not a
configuration for high volume or complex implementations. To determine the correct
configuration for your production, test, and development environments, you should work
with your hardware and/or implementation consultants.

Web User

You must have a computer capable of running one of the supported browsers (see the Oracle
Transportation Management Technical Architecture document for a list of supported browsers). Many
factors will affect the performance experience of the end-user, including: CPU type & speed; operating
system version; available memory; hard drive speed; network card speed and network bandwidth
between the browser and the web server.

Note: Popup Blockers may prevent your browser from working correctly with Oracle
Transportation Management. If you experience any problems, try disabling them before
contacting Technical Support.
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Note: If you want to view the results generated by the Load Configuration feature, a VRML
plug-in for your Web Browser is needed. Oracle Transportation Management has been tested
with the Cortona plug-in for Internet Explorer, available at:
http://www.parallelgraphics.com/products/cortona/.

Test and Development Server

e Combined Web & App: 2 x 3.0 GHz dual-core Xeon CPU, 6 GB RAM, 80 GB disk
Note: For the database server, please see the documentation associated with that product.

Production Servers

e Web Server: 2 x 2.5 GHz quad-core Xeon CPU w/ 18 MB cache, 6 GB RAM, 80 GB disk
e Application Server: 2 x 2.5 GHz quad-core Xeon CPU w/ 18 MB cache, 8 GB RAM, 80 GB disk
Note: For the database server, please see the documentation associated with that product.

Software Requirements

e 64-bit Oracle Enterprise Linux (OEL) Server 5.1 with the latest recommended patches
e Oracle 11gR2 (11.2.x) Database Enterprise Edition
e Oracle WebLogic Server Standard Edition 11gR1 (10.3.3.x)
e Integration Server - EAI solution (optional)
The following software is distributed with Oracle Transportation Management:

e Apache Web Server 2.2.16

e Tomcat Java Servlet Server 6.0.18

e OpenSSL 0.9.80

e Zlib1.2.3

e 64-bit JRockit JDK 1.6.0_20 (R28.0.1)
e Python 2.5.2

The Oracle Transportation Management software is distributed on DVD or via download from standard
Oracle channels.

Preparing to Install Oracle Transportation Management

Before you begin the installation process, ensure that the following is complete:

e A compatible operating system is installed (see above) along with any patch bundles
recommended by the OS vendor.

e The size of the swap space on your server is equal to or greater than the amount of memory it
contains.

e All Oracle Transportation Management servers are time-synced using a process like NTP. This
is critical to the proper operation and troubleshooting of an Oracle Transportation Management
instance.

e Oracle 11gR2 (11.2.x) Database Client (Administrator install) has been installed and
configured to connect to your database.

Pre-Install Setup

Once the Oracle Enterprise Linux Server release 5.1 operating system is installed, you need to modify
kernel parameters to ensure that the OS works properly with the application server.
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1. Update kernel parameters as needed for the Database Client. This is covered in the Oracle
Database installation documentation.

2. Restart the server.
The following parameters may improve your server’s performance. Your system administrator should
evaluate each of the settings below and implement them as necessary:
<none>
3. Improve file system performance by mounting them with the “noatime” parameter in
/etc/fstab.
Creating the Oracle Transportation Management User

You must add a group and user on the application server called ‘otm’.

Start the User Manager tool.
Add a group called ‘otm’.

o o &

Add a user called ‘otm’ and set a password for the otm user.
7. Assign the otm user to the otm group.
Installing WebLogic on the Application Server

Install WebLogic Server version 11g as per the accompanying documentation. Note the BEA Home
directory (e.g. /opt/bea) and the WL Home directory (e.g. /opt/bea/weblogicl1lg).

Note: The user that Oracle Transportation Management runs as must have read access to
the WebLogic install directory and all of its sub-directories.

Installing Oracle Transportation Management

Follow the instructions in the Installing Oracle Transportation Management chapter to finish your
Oracle Transportation Management installation. You must be logged in as Administrator or someone
with Administrative privileges to install Oracle Transportation Management successfully.
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2. Installing Oracle Transportation Management

It is HIGHLY recommended that you make available personnel who are familiar with the installation
and configuration of Windows or UNIX based applications (depending on operating system you are
installing on.) Also, we recommend that, in the case of the Oracle Database, that you have on hand an
administrator familiar with the creation and support of Oracle Database instances. A Network
Administrator may be necessary at times — especially during the configuration of systems that will be
accessed through firewalls, VPN, etc.

Note: Sections that are specific to the type of application server being used are marked
with [WebLogic] or [WebSphere]. Similarly, operating system-specific sections are
marked with [AIX], [Linux], etc.

Important Note Regarding Third-Party Software

Oracle Transportation Management uses several third-party components to run the basic system.
Many of these are shipped with the product, but several are not, including some that are required to
even start Oracle Transportation Management’s servers. Please read the ReadMe.txt file included
with the product documentation, in the same location that you found this Administration
Guide. This file is also shown at the end of the install process.

Explanation of Application Layers

Oracle Transportation Management is made up of many components that can be grouped into the
following “layers”:

e Database Layer - where the data actually resides
e Application Layer - where the application logic runs (one of: WebLogic or WebSphere)

Note: WebSphere Application Server has not yet been certified with Oracle Transportation
Management 6.2; there is no ETA on when this will be completed.

e Web Layer - the UI that users interact with (Tomcat & Apache)

e Oracle Fusion Transportation Intelligence Layer - where Oracle Business Intelligence Enterprise
Edition (OBIEE) is run

¢ Integration Layer - where incoming XML data is handled; this is just a normal Oracle
Transportation Management web instance that the client designates as being used for handling
integration in addition to, or instead of, handling normal user traffic; please see the Oracle
Transportation Management Integration Guide and the Oracle Transportation Management
Data Management Guide for alternatives to using web-layer integration.

Whether or not an Oracle Transportation Management web instance is handling user traffic is as
simple as whether or not users know to access the instance. In order to set up a separate integration
web server, your upstream processes simply need to know where to send data to and your users
should not be directed to use it.

Recommended Installation Steps

Oracle Transportation Management can be installed in various configurations to provide scalability for
production instances, or to provide for consolidation of system resources for test/development
instances.

Production instances of Oracle Transportation Management will normally run each of the above
application layers on separate physical servers. For instance, we would see the following
configuration:
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e Server One: Database layer

e Server Two: Application Layer

e Server Three: Web layer

e Server Four: Integration layer

e Server Six: Oracle Fusion Transportation Intelligence layer

The instructions that follow assume that you are installing a production instance of Oracle
Transportation Management where the various layers reside on separate physical servers. If you want
to install a test or development instance of Oracle Transportation Management, please see the
Installing Oracle Transportation Management on a Single Server section.

Test instances can be consolidated onto fewer servers, depending on the hardware availability within
your organization. Commonly, we will see the following configuration for test instances:

e Server One: Database and Oracle Fusion Transportation Intelligence layers
e Server Two: Web, Application and Integration layers

If the test server has enough resources (Memory/CPU), it is possible to run everything on a single
system. This should ONLY be done for test instances and is NOT recommended for any production
level use. Please contact Technical Consulting if you have any questions.

Installer Interface Options

Depending on the OS, Oracle Transportation Management can now be installed using one of three
options: GUI, Console, and Silent. All installation capabilities are available on all options; it's simply a
matter of preference and convenience in deciding which one to use.

GUI Interface

The GUI option is available on all platforms. It uses the native windowing system (e.g. X11) to interact
with the user. Under Unix/Linux systems, this requires you to have an X display running, and to have
the DISPLAY environment variable set correctly. See your local System Administrator if you need help
setting this up. To use this interface, simply run the installer executable with no further options:

$ ./otmv620 <platform>.bin
Console Interface

The Console interface option is available on all platforms. It runs on the command line and interacts
with the user through a text-only interface. To use this interface, run the installer executable with a
single option:

$ stty erase "H
$ ./otmv620 <platform>.bin -i console

Silent Installer

The Silent Installer interface option is available on all platforms except Windows. A file is prepared
ahead of time answering all of the questions that the installer would normally ask. The installer will
read it in when it executes and then run completely hands-free. To use the silent installer option, run
the installer executable with two options, one to select the silent interface and one to specify the
response file to use:

$ ./otmv620 <platform>.bin -i silent -f installer.properties
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Installing with the Silent Installer

Before installing Oracle Transportation Management with the silent option, you must locate, rename,
and edit the response file. It is called example.installer.properties and is located in the same
directory as the installer executable itself.

1.

Make a copy of example.installer.properties and save it to a new name (e.g.
installer.properties).

Edit the new file and fill in the answers as appropriate for your environment. All values are
documented in the file itself. Note that some sections are only for certain platforms, or are
specific to the web or application server installs; all should be clearly marked.

Run the installer executable from the command line with the following options:

$ ./otmv620 <platform>.bin -i silent -f installer.properties

where <platform> is the name of the platform you are on and installer.properties is the
name of the file that you edited in the previous step.

Note: On UNIX/Linux systems, the installer extracts to /tmp, and you will receive an error
if there is not sufficient room there for the installer to extract itself. If you need to change
this directory you must set the IATEMPDIR environment variable:

$ export IATEMPDIR=/some/other/temp/directory
$ ./otmv620 <platform>.bin -i silent -f installer.properties

Once the installer has finished (5-20 minutes, depending on your OS and hardware) you
should see the message:

Installation Complete.

Check the bottom of the installation log file, Oracle O0TM v6.2 GA Installlog.log, for any
errors or warnings (this file should be located in the directory that Oracle Transportation
Management was installed to). If there are any errors, please correct them (they should be
self explanatory). If you find that you need help, please have the log file handy, along with the
Exit Code (found in the log file), before contacting Oracle Support. If you do not get the
“Installation Complete.” message or cannot find the log file, look for a file of the same name in
your home directory (i.e. $SHOME/Oracle OTM v6.2 GA Installlog.log).

Note: After a successful install using the silent installer you must remember to login as
root and run the root.sh file according to the instructions at the end of the log file. Oracle
Transportation Management will not run correctly until you do so.

Note: There are additional libraries that are required in order for Oracle Transportation
Management to work properly. Please view the ReadMe. txt file for information on where to
obtain and install these additional libraries.

Please refer to the sections at the end of Installing Interactively on the Application Server and
Installing Interactively on the Web Server for further post-install activities that need to be
done before you can start up the application.

Installing Interactively on the Application Server

Note: Paths shown in this section will be in UNIX format (Ex. /opt/gc3) but should be in
Windows format for Windows installs (Ex. D:/gc3 or D:\gc3). All directions are generic
across all operating systems unless explicitly noted. Similarly, all instructions apply
regardless of which Application Server you are using, unless otherwise noted.
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1. Start the installer in GUI or console mode, as directed in the section above.

Note: On UNIX/Linux systems, the installer extracts to /tmp, and you will receive an error
if there is not sufficient room there for the Installer to extract itself. If you need to change
this directory you must set the IATEMPDIR environment variable:

$ export IATEMPDIR=/some/other/temp/directory

$ ./otmv620 <platform>.bin -i console

2. Read the installation notice and click Next.

3. Carefully read the Third-Party Software notice and click Next.

4. Choose the installation directory (e.g. /opt/otm or /opt/otm620 to denote version). If you are
installing more than one Oracle Transportation Management instance on a server, each
instance must be installed into a different directory.

5. Choose ‘App Server’ to install the application server only and click Next.

6. Read the instructions for filling out the required data and click Next.

7. General Settings:

a. Enter the Web Server External Fully Qualified Domain Name (e.g.
otmweb.oracle.com). This would work if ‘otmweb’ is the server name and oracle.com
is the domain name. If your site were accessed through a load-balancer or NAT device,
this would be the external URL (outside your network). If not, then this would be the
FQDN of your web server from within your network.

b. Enter the Web Server External Port (usually 80). If your site were accessed through a
load-balancer or NAT device, this is the external port. If not, then this is the port on
your web server.

c. Enter the Web Server Fully Qualified Domain Name. This may or may not be the same
as the Web Server External FQDN. Please contact your Network Administrator if you
have any questions about this.

Enter the Web Server Port (usually 80).

e. Enter the Fully Qualified Domain Name of your application server, which is the name of
your server and the domain name (e.g. otmapp.oracle.com).

f. Click Next.

8. General Settings (continued)

a. Enter the Application Server Port (WebLogic: 7001, WebSphere: 2809).

b. Enter the Database Server Fully Qualified Domain Name that is the name of your
database server and the domain name (e.g. otmdb.oracle.com).

c. Enter the Database Server Port. This is usually 1521.

Enter the Database Connect String. This is the DB connect string as setup in your
tnsnames.ora file under the Oracle client installation. Contact your Oracle
Administrator for this information.

e. Enter the Database Service Name. Contact your Oracle Administrator for this
information.

f. Click Next.

9. General Settings (continued)

a. Enter Oracle Home Path where you installed the Oracle client
(/u01/app/oracle/product/11g, for instance).

b. Enter the URL Prefix, if your web server is running behind a reverse-proxy or SSO
solution. Otherwise, you can accept the default.

c. Enter SMTP Server Fully Qualified Domain Name. This server name is necessary to
send email notifications from within Oracle Transportation Management. Please
contact your Network Administrator for this information.

2-4 Copyright © 2001, 2012, Oracle and/or its affiliates. All rights reserved.



d. Enter the Default Reply-To Email Address that all email notifications will appear to
come from. This must map to a real mailbox and will allow you to check for bounced
messages or delivery failures.

e. Click Next.
10. App Server Settings: WeblLogic-Specific

a. [WebLogic only] Enter the BEA Home Path (e.g. /opt/bea).
11. App Server Settings

a. Enter the Application Server IP Address.

i. [WebLogic] The application server will be bound to this IP address
specifically. If you are installing more than one Oracle Transportation
Management instance on a server, each instance must be bound to a different
IP address. Please contact your Network or UNIX Administrators for more
information on creating virtual IP addresses within a server.

ii. [WebSphere] Oracle Transportation Management does not currently support
running more than one WebSphere instance of Oracle Transportation
Management on a single box.

b. Enter the Application Server Path, which is the directory that you installed the
Application server software into (e.g. /opt/bea/weblogicl1g or
/opt/IBM/WebSphere/AppServer6).

c. Enter the Application Server memory in megabytes, which is the amount of system
memory that the application server memory uses. This default is 1600MB, but may be
higher depending on your configuration.

Note: If this value is lower than 1600MB, the application server may not start. Also, please
take into consideration whether the server will be used for test/development or production,
and what system resources are available.

d. Enter the Oracle Transportation Management App Server Init Script / Service name
(e.g. otmapp620). If installing more than one Oracle Transportation Management
instance on a single server, this must be unique for each one.

e. Click Next.
12. [WebSphere or AIX only] App Server Settings (continued)

a. Enter the number of logical CPUs in the server. This is used to set a JVM performance
parameter.

13. [UNIX Only] UNIX Settings

a. Enter the user name that the Oracle Transportation Management programs will run
under (e.g. otm or otm62).

b. Enter the group name that the Oracle Transportation Management programs will run
under (e.g. otm or otm62).

c. Click Next.

Note: The installer will try to verify the user and group names that you enter against the
/etc/passwd and /etc/group files. If the installer cannot verify these names (e.g. you
mistyped them or you use something like LDAP or NIS to manage users and groups on this
server), you will be prompted to correct them or validate that they are correct and continue
with the installation. Similarly, the installer will use the /etc/passwd file to look up the
home directory of the user you entered; if it cannot determine what the home directory is
or cannot locate the actual directory, you will be prompted to correct it or verify that it is
accurate and continue the installation.

14. Choose whether or not to migrate custom settings from a previous Oracle Transportation
Management installation (3.7 or later). If you answer yes, you’ll need to choose the directory
where your old glog.properties file is located.
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15.

Click Next.

16. Choose the optional components with which Oracle Transportation Management will integrate.
Depending on what you choose, the installer may prompt for additional configuration
information.

a. [Console Install Only] Enter all components that you wish to integrate with using a
comma-separated list (no spaces).

17. If you are using a Replicated Operational Database, enter the following:

a. Fully Qualified Domain Name of the ROD Server
b. Port that Oracle is using on the ROD server (usually 1521)
c. Connect String for the ROD database
d. Service Name of the ROD database
e. Click Next.
18. If you are integrating with a locally-hosted MapViewer instance, enter the following:
a. Fully Qualified Domain Name of the locally-hosted MapViewer server
b. Service Name of the locally-hosted MapViewer
c. Base Map name for the locally-hosted MapViewer
d. Click Next.
19. If you are integrating with Oracle Fusion Transportation Intelligence (FTI), enter the following:
a. Fully Qualified Domain Name of the Oracle Fusion Transportation Intelligence web
server
b. Port number of the Oracle Fusion Transportation Intelligence web server
c. Fully Qualified Domain Name of the Oracle Fusion Transportation Intelligence database
server
d. Port that Oracle is using on the Oracle Fusion Transportation Intelligence database
server (usually 1521)
e. Click Next.
f. Oracle Fusion Transportation Intelligence database schema name (e.g. hdowner)
g. Oracle Fusion Transportation Intelligence database SID
h. Oracle Fusion Transportation Intelligence database username (e.g. hdowner)
i. Password for the Oracle Fusion Transportation Intelligence database user
j. Click Next.
k. Fully Qualified Domain Name of the Oracle Data Integrator (ODI) Master Repository
Server
I.  Port number for the ODI Master Repository Server (usually 1521)
m. ODI Master Repository Database SID
n. ODI Master Repository password
0. Click Next.
p. Fully Qualified Domain Name of the ODI Agent Server
g. Port number for the ODI Agent Server (usually 20910)
r. ODI Agent password
s. ODI Work Repository Code
t. Click Next.
20. If you are integrating with an Oracle Spatial server, enter the following:
a. Fully Qualified Domain Name of the Oracle Spatial server
b. Port number of the Oracle Spatial server
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21.

22.

23.

24,

25,

26.

27.

28.

€.

f.

The full path and name of the Route servlet for US/Canada that the Oracle Spatial
server hosts

The full path and name of the Route servlet for Western Europe that the Oracle Spatial

server hosts
The full path and name of the GeoCode servlet that the Oracle Spatial server hosts
Click Next.

If you are integrating with FAXMaker or RightFax, enter the following:

a.
b.
C.

Phone number that faxes will seem to originate from
Email address that the fax server polls
Click Next.

If you are integrating with SMC RateWare server, enter the following:

a 0 T o

e.

SMC RateWare Fully Qualified Domain Name
SMC RateWare Server Port (usually 23700)
Click Next.

Indicate whether or not you are running SMC RateWare Version 1.2.325 (or later) or

SMC Carrier Connect
Click Next.

If you are integrating with SMC RateWareXL, enter the following:

a 0o T o

SMC RateWareXL Username
SMC RateWareXL Password
SMC RateWareXL License Key
Click Next.

If you are integrating with PCMiler WorldWide, enter the following:

a.
b.
C.

Fully Qualified Domain Name of the PCMiler WorldWide server
PCMiler WorldWide port (usually 8145)
Click Next.

If you are integrating with PCMiler Rail, enter the following:

a.
b.
C.

Fully Qualified Domain Name of the PCMiler Rail server
PCMiler WorldWide port (usually 2001)
Click Next.

If you are integrating with Rand McNally IntelliRoute Server, enter the following:

SO a0 T

IP address of the Rand McNally IntelliRoute server

Rand McNally IntelliRoute server port (usually 1998)

IntelliRoute user name setup during the IntelliRoute server installation (e.g. otm)
IntelliRoute password setup during the IntelliRoute server installation

IntelliRoute location setup during the IntelliRoute server installation

Click Next.

If you are integrating with Rand McNally MileMaker Server, enter the following:

a.
b.
C.

Enter the Fully Qualified Domain Name of the MileMaker server
Enter the MileMaker server port (usually 1031)
Click Next.

If you are integrating with Kewill’s FlagShip server, enter the following:

a.
b.

Fully Qualified Domain Name of the Kewill FlagShip server
FlagShip server port (usually 1200)
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29.

30.

31.

32.

33.

c. Enter the Oracle Transportation Management Location Refnum Qualifier GID used to
cross-reference with the Kewill data

d. Click Next.

Please review the summary before continuing and click Next when ready to proceed. The file
copy process may take some time - please be patient.

Once the files are copied, the installation program prompts you to begin configuring Oracle
Transportation Management. This step takes a few minutes (typically one to five minutes).

[UNIX Only] The installer will prompt you to log in as root and run the root.sh script. This
must be completed for a successful installation.

Note: There are additional libraries that are required in order for Oracle Transportation
Management to work properly. Please view the ReadMe. txt file for information on where to
obtain and install these additional libraries.

[Windows Only] When finished, you must restart your entire server before attempting to
start Oracle Transportation Management.

Apply the latest Oracle Transportation Management consolidated update before starting up
your server. Contact Technical Support for information and assistance.

IMPORTANT NOTE FOR WebSphere ONLY

After installing Oracle Transportation Management, you must deploy the application properly within
WebSphere. To do that, please do the following:

1. Log in to the application server as ‘root’
2. Execute the following commands, initially as root, then as the user that Oracle Transportation
Management runs as. In all cases:
a. <otm_install_path> is the name of the directory where Oracle Transportation
Management was installed to
b. <otm_user> is the account that Oracle Transportation Management runs as
c. <ws_pwd> - password for ‘system’ WebSphere user (default: CHANGEME)
3. Undeploy the application (Note: you must do this, even if it’s the first install of Oracle
Transportation Management on this server). After each step, ensure that there are no errors:
# cd <otm install path>/websphere/profiles/default/bin
# ulimit -n 8096
# su <otm_user>
$ ./wsadmin.sh serverl -username system -password <ws_ pwd> -conntype NONE -f
undeployGC3SS.jacl
$./wsadmin.sh serverl -username system -password <ws pwd> -conntype NONE -f
undeployGC3.jacl
After each JACL script is run, there should be a message indicating that the application was
successfully uninstalled. It is safe to ignore the following error:
websphere/profiles/default/bin/setupCmdLine.sh: line 35: ulimit: open files:
cannot modify limit: Operation not permitted
4. Deploy the application. After each step, ensure that there are no errors:
# cd <otm install path>/websphere/profiles/default/bin
# ulimit -n 8096
# su <otm_user>
$ ./wsadmin.sh serverl -username system -password <ws_ pwd> -conntype NONE -
javaoption -Xms512m -javaoption -Xmx512m -f deployGC3SS.jacl
$ ./wsadmin.sh serverl -username system -password <ws_ pwd> -conntype NONE -
javaoption -Xms512m -javaoption -Xmx512m -f deployGC3.jacl
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After each JACL script is run, there should be a message indicating that the application was
successfully installed. It is safe to ignore the following error:

websphere/profiles/default/bin/setupCmdLine.sh: line 35: ulimit: open files:
cannot modify limit: Operation not permitted

There are two shell scripts available to use to help automate this task. They are located in:
<otm_install_path>/websphere and are named “undeployOTM.sh” and “deployOTM.sh".

Startup Scripts (UNIX Only)

The startup scripts are copied to /etc/rc.local on AIX, /sbin/init.d on HP-UX, and /etc/init.d on Linux
and Solaris. The default names are shown below, but may differ, depending on what names you
specified in the installer.

e otmapp62 (Oracle Transportation Management Application Server)
Property Files on the Oracle Transportation Management Application Server

e glog.properties (<otm_install_path>/glog/config)
Weblogic only

e config.xml.fresh (<otm_install_path>/weblogic/domains/otm/config)
e weblogic.sh / weblogic.bat (<otm_install_path>/weblogic)
e weblogic.conf (<otm_install_path>/weblogic)

Log Files on the Oracle Transportation Management Application Server

e glog.app.log (<otm_install_path>/logs) - automatically rotates
e glog.exception.log (<otm_install_path>/logs) - automatically rotates

Weblogic only

e console.log.0 (<otm_install_path>/logs/weblogic) — automatically rotates

e shutdown.log.0 (<otm_install_path>/logs/weblogic) - automatically rotates

e startup.out (<otm_install_path>/logs/weblogic) - overwritten on each restart

e weblogic.log (<otm_install_path>/logs/weblogic) — grows over time
WebSphere only

e console_out.log (<otm_install_path>/logs/websphere) — automatically rotates
e console_err.log (<otm_install_path>/logs/websphere) — automatically rotates

Installing Interactively on the Web Server

Note: Paths shown in this section will be in UNIX format (Ex. /opt/gc3) but should be in
Windows format for Windows installs (Ex. D:/gc3 or D:\gc3). All directions are generic
across all operating systems unless explicitly noted. Similarly, all instructions apply
regardless of which Application Server you are using, unless otherwise noted.

1. Start the installer in GUI or console mode, as directed in the section above.

Note: On UNIX/Linux systems, the installer extracts to /tmp, and you will receive an error
if there is not sufficient room there for the installer to extract itself. If you need to change
this directory you must set the IATEMPDIR environment variable:
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$ export IATEMPDIR=/some/other/temp/directory
$ ./otmv620 <platform>.bin -i console

2. Read the installation notice and click Next.
3. Carefully read the Third-Party Software notice and click Next.

4. Choose the installation directory (e.g. /opt/otm or /opt/otm620 to denote version). If you are
installing more than one Oracle Transportation Management instance on a server, each
instance must be installed into a different directory.

5. Choose “Web Server” to install the Web Server only and click Next.
6. Read the instructions for filling out the required data and click Next.

7. General Settings

a.

f.

Enter the Web Server External Fully Qualified Domain Name (e.g.
otmweb.oracle.com). This would work if ‘otmweb’ is the server name and ‘oracle.com’
is the domain name. If your site were accessed through a load-balancer or NAT device,
this would be the external URL (outside your network). If not, then this would be the
URL to your web server from within your network.

Enter the Web Server External Port (usually 80). If your site was accessed through a
load-balancer or NAT device, this is the external port. If not, then this is the port on
your web server.

Enter the Fully Qualified Domain Name of your web server. This may or may not be
the same as the Web Server External URL. Please contact your Network Administrator
if you have any concerns about this.

Enter the Web Server Port (usually 80).

Enter the Fully Qualified Domain Name of your application server, which is the name of
your server and the domain name (e.g. otmapp.oracle.com).

Click Next.

8. General Settings (continued)

a.
b.

e.

f.

Enter the App. Server Port (WeblLogic: 7001, WebSphere: 2809).

Enter the Database Server Fully Qualified Domain Name that is the name of your
database server and the domain name (e.g. otmdb.oracle.com).

Enter the Database Server Port. This is usually 1521.

Enter the Database Connect String. This is the DB connect string as setup in your
tnsnames.ora file under the Oracle client installation. Contact your Oracle
Administrator for this information.

Enter the Database Service Name.
Click Next.

9. General Settings (continued)

a.

€.

Enter Oracle Home Path where you installed the Oracle client
(/u01/app/oracle/product/11, for instance) and click Next.

Enter the URL Prefix, if your web server is running behind a reverse-proxy or SSO
solution. Otherwise, you can accept the default.
Enter SMTP Server Fully Qualified Domain Name. This server name is necessary to

send email notifications from within Oracle Transportation Management. Please
contact your Network Administrator for this information.

Enter the Default Reply-To Email Address that all email notifications will appear to
come from. This must map to a real mailbox and will allow you to check for bounced
messages or delivery failures.

Click Next.

10. Web Server Settings
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a. Enter the Web Server IP Address. Apache will be bound to this IP address. If you are
installing more than one Oracle Transportation Management instance on a server,
each instance must be bound to a different IP address. Please contact your Network or
UNIX Administrators for more information on creating virtual IP addresses within a
server.

b. Enter the Web Server SSL Port (usually 443).

c. Enter the Oracle Transportation Management Web Server Service/Init Script name
(e.g. otmweb62). If installing more than one Oracle Transportation Management
instance on a server, this must be unique for each one. This script will be created
under /etc/init.d (UNIX only).

d. Enter the Tomcat Data Port (usually 8009).
e. Enter the Tomcat Shutdown Port (usually 8007).

Note: This port must be unique for every Oracle Transportation Management instance on a
physical server, since it binds to 127.0.0.1.

f. Click Next.
11. Web Server Settings (continued)

a. Enter the Tomcat Memory in Megabytes. This is the amount of system memory that
Tomcat will use. This is 1600Mb by default, but may be higher or lower, depending on
your configuration.

Note: If this value is lower than 1600MB, Tomcat may not start. Also, please be sure
to note whether this server will be used for test/development or production, and what
system resources it has available.

b. Click Next.
12. [WebSphere or AIX only] Web Server Settings (continued)

a. Enter the number of logical CPUs in the server. This is used to set a JVM performance
parameter.

13. [Windows only] Web Server Settings (continued)

a. Enter the Oracle Transportation Management Tomcat Server Service name (e.g.
otmwebtomcat62). If installing more than one Oracle Transportation Management
instance on a server, this must be unique for each one.

14. [WebSphere only] Web Server Settings (continued)

a. Enter the WebSphere Client Home directory, which is the directory you specified when
installing WebSphere Client. (e.g. /opt/IBM/WebSphere/AppClient)

15. [UNIX Only] UNIX Settings

a. Enter the user name that the Oracle Transportation Management programs will run
under (e.g. otm or otm62).

b. Enter the group name that the Oracle Transportation Management programs will run
under (e.g. otm or otm62).

c. Click Next.

Note: The installer will try to verify the user and group names that you enter against the
/etc/passwd and /etc/group files. If the installer cannot verify these names (e.g. you
mistyped them or you use something like LDAP or NIS to manage users and groups on this
server), you will be prompted to correct them or validate that they are correct and continue
with the installation. Similarly, the installer will use the /etc/passwd file to look up the
home directory of the user you entered; if it cannot determine what the home directory is
or cannot locate the actual directory, you will be prompted to correct it or verify that it is
accurate and continue the installation.
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16.

17.

18.

19.

20.

21.

22.

23.

Choose whether or not to migrate custom settings from a previous Oracle Transportation
Management installation (3.7 or later). If you answer yes, you’ll need to choose the directory
where your old glog.properties file is located. Click Next.

Choose the optional components with which Oracle Transportation Management will integrate.
Depending on what you choose, the installer will prompt for the appropriate configuration
information.

a. [Console Install Only] Enter all components that you wish to integrate with using a
comma-separated list (no spaces).

If you are integrating with a Replicated Operational Database, enter the following:
Fully Qualified Domain Name of the ROD server

Port that Oracle is using on the ROD server (usually 1521)

Connect String for the ROD database

Service Name of the ROD database

Click Next.

If you are integrating with a locally host MapViewer instance, enter the following:

©® a0 oo

a. Fully Qualified Domain Name of the MapViewer server
b. Service Name of the locally hosted MapViewer

c. Base Map name for the locally hosted MapViewer

d. Click Next.

Review the summary and click next when ready to proceed. The file copy process may take a
while and may appear to hang - please be patient. Once the files are copied, the Install
Program prompts you to begin configuring Oracle Transportation Management. Click next
when you are ready to proceed. This step takes a few minutes (typically one to five minutes).

[UNIX Only] The installer will prompt you to log in as root and run the root.sh script. This
must be completed for a successful installation.

Note: There are additional libraries that are required in order for Oracle Transportation
Management to work properly. Please view the rReadMe. txt file for information on where to
obtain and install these additional libraries.

[Windows Only] When finished, you must restart your entire server before attempting to
start Oracle Transportation Management.

Apply the latest Oracle Transportation Management consolidated update before starting your
server. Contact Technical Support if you need assistance.

Startup Scripts (UNIX Only)

The startup scripts are copied to /etc/rc.local on AIX, /sbin/init.d on HP-UX, and /etc/init.d on Linux
and Solaris. The default names are shown below, but may differ, depending on what names you
specified in the installer.

otmweb62 (Oracle Transportation Management Web Server)

Property Files on the Oracle Transportation Management Web Server

glog.properties (<otm_install_path>/glog/config)
httpd.conf (<otm_install_path>/apache/conf)
mod_jk.conf (<otm_install_path>/apache/conf)
tomcat.sh / tomcat.bat (/gc3/tomcat/bin)
tomcat.conf (/gc3/tomcat/bin)

server.xml (/gc3/tomcat/conf)
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Log Files on the Oracle Transportation Management Web Server

e access.log (<otm_install_path>/logs/apache) — may grow quickly

e console.log.0 (<otm_install_path>/logs/tomcat) - automatically rotates

e error.log (<otm_install_path>/logs/apache) - will grow over time

e glog.web.log (<otm_install_path>/logs) - automatically rotates

¢ mod_jk.log (<otm_install_path>/logs/apache) - will grow over time

e shutdown.log.0 (<otm_install_path>/logs/weblogic) - automatically rotates

e startup.out (<otm_install_path>/logs/weblogic) — overwritten on each restart
e ssl.log (<otm_install_path>/logs/apache) - will grow over time

Installing Oracle Transportation Management on a Single Server

You can install Oracle Transportation Management on a single server for testing and development
purposes. You can install them as separate instances, in which case you simply run the above steps
multiple times on the same server, once for each new instance. You can also install a combined Web
and Application instance at once. Follow the directions for Installing Interactively on the
Application Server but choose “"Web & App Server” on the “Choose Install Type” screen.

Installing More Than One Instance of Oracle Transportation
Management on a Single Server

Oracle does not support installing more than one version of Oracle Transportation Management onto a
single server (or virtual server) unless each instance is bound to a different IP address. This can be
accomplished by having separate network cards, each with their own IP address, or using virtual IP
addresses. Please contact your System Administration team for the configuration and maintenance of
this.

Starting & Stopping Oracle Transportation Management Servers

Please see the section “Starting & Stopping Oracle Transportation Management Servers” in the
Administration Guide.
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3. Installing Oracle Transportation Management on the
Database Server

You should have your Database Administrator install the Oracle database and fine-tune it for
performance. Once Oracle is installed, follow these steps to complete the process.

These steps outline the procedures to set up an Oracle database for Oracle Transportation
Management. It requires that Oracle Database Server 11gR2 be installed and be patched with the
latest recommended patch updates and an Oracle database be created. Please note that the Oracle
Transportation Management database scripts are located under
<otm_install_path>/glog/oracle/script8 on the Oracle Transportation Management Application server.

Requirements

Oracle Version: 11.2.x Database Enterprise Edition
Oracle Options: Jserver, JAccelerator, Partitioning (optional/strongly recommended)
Oracle Instance Character Set: UTF8

Initial Parameters
The following initial parameters must be set:
Open cursors = 1000 (or greater)

Please refer to the init.ora file in <otm_.install_path>/glog/oracle/script8 for recommendations on
other parameters.

Create Tablespaces

The following tablespaces are required to be created first. As the database grows, more datafiles
should be added to accommodate the application. For performance purposes, all tablespaces should be
on different physical disks (if available) or on RAID 0+1 storage.

Required Tablespaces for Oracle Transportation Management database

For a partitioned database, required tablespaces and initial file sizes are listed below:

Tablespace Initial File Size
ARCHIVE 1GB

DATA 1.5GB

INDX 3 GB

REPORT 1 GB
REPORTINDX 1 GB

BPL_DAY1 1 GB

BPL_DAY2 1 GB
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Tablespace Initial File Size

BPL_DAY3 1GB
BPL_DAY4 1GB
BPL_DAY5 1GB
BPL_DAY6 1GB
BPL_DAY7 1GB
PART_1 1GB
PART_2 1GB
PART_3 1GB
PART_4 1GB
PART_5 1GB

MSG_PART_TBS1 | 1 GB

LOB1 1GB
LOB2 1GB
LOB3 1GB
LOB4 1GB
LOBS 1GB
LOB6 1GB
LOB7 1GB

MSG_LOB_TBS1 1GB

TEMP 1GB

For a non-partitioned database, required tablespaces and initial file sizes are listed below:

Tablespace Initial File Size
ARCHIVE 1GB

DATA 1.5 GB

INDX 3GB
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Tablespace Initial File Size

REPORT 1GB

REPORTINDX 1GB

LOB1 1GB
LOB2 1GB
LOB3 1GB
LOB4 1GB
LOBS 1GB
LOB6 1GB
LOB7 1GB

MSG_LOB_TBS1 | 1 GB

TEMP 1GB

These tablespaces should be created first. A database administrator can write a script to create the
tablespaces or use the provided procedure, which is described below. We recommend all Oracle
Transportation Management tablespaces are locally managed with automatic segment space
management.

The sizes specified above are minimal for the successful installation of the Oracle Transportation
Management database. LOB tablespaces are used to hold LOB objects, which are usually very space
consuming. If the database is being used immediately with integrations, we recommend double the
size of these tablespaces at the creation time. We also recommend giving 20% - 50% more space to
the other tablespaces.

Using Provided Procedure to Create Tablespaces

We provide a SQL script, create_gc3_tablespaces.sql, to create all tablespaces of the Oracle
Transportation Management database. When you run this script, you are prompted for options, which
are explained below. All of the tablespaces are locally managed with uniform size set as 5MB for LOB
tablespaces and 1MB for the others. Only one datafile is created for each tablespace. The datafiles of
all tablespaces are created in the same directory that you specify. If you want to create dictionary-
managed tablespaces, and/or create tablespaces in different file systems/directories, you should run
the script with Execute Now option set to N. This way the process will generate create tablespaces
statements in a log file. You can modify the statements and run them later manually.

This script creates LOB tablespaces with 16 KB block size. This is the recommended block size for
optimal performance. In order to create a tablespace with 16 KB block size, you should have the
following init.ora parameter set if your database standard block size is not 16 KB. Change the cache
size as needed for your database.

db 16k cache size = 104857600 # 100MB for 16k block buffers

e To run the script, log in to the database as user SYS and run script:

create gc3 tablespaces.sql.
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Create Tablespace Options

e ROD database (Y/N)

The primary Oracle Transportation Management database is OLTP (Online Transaction Processing)
type and also referred to OLTP. A secondary database referred as ROD (Replicated Operational
Database) is also an option. Oracle Transportation Management requires different tablespaces in this
ROD database; therefore, if you are setting up an ROD database, enter Y. Otherwise enter N.

e Partition Option (Y/N)

In the Oracle Transportation Management OLTP database, most integration tables are partitioned for
the purpose of easy maintenance. There are some other tables that are also partitioned. To
accommodate the partitioned tables, there are dedicated tablespaces for these partitions. But if your
database is not partition-enabled and you are not planning to add the partitioning option of Oracle,
you can have the partitioned Oracle Transportation Management tables created without partitioning.
In this case, you will not need the partition tablespaces and you should enter N for this option. The
default is Y. Your ROD database is not partitioned. So this question is irrelevant if you are creating
ROD database tablespaces. Hit Enter in that case.

e Parameter Default Option (Y/N)

This process sets the following parameters with default values. If you do not want to use these values,
you should enter N. The default is Y.

file size: 1GB
maximum file size(if auto extend is on): 2GB

e Parameter Value Option

If you choose N for Parameter Default Option, you can enter values you want for the above
parameters. Otherwise, just press Enter.

e Autoextend Option
Enter N if you do not want your datafiles to be autoextended. Default is Y.

¢ Datafile directory

Enter full path of datafiles directory. The trailing slash (/) for UNIX/Linux or back-slash (\) should be
included.

e Executing-Now Option

Enter Y if you want to let the process to create tablespaces for you. Otherwise the process will
generate create statements in the log file. Default is N.

Create Oracle Transportation Management Database Structure and Public Data

These steps will create database users, structure and load public data. These steps will create
following users on the database:

e ARCHIVE

e GLOGDBA

¢ GLOGOWNER
e GLOGDEV

¢ GLOGLOAD
e REPORTOWNER
e GLOBALREPORTUSER
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The database users created have a password that matches their userid.

1.

Set environment variable ORACLE_SID to your database SID. If the ORACLE_SID is not set
within the system environment, you must set this within your current command prompt by
typing “export ORACLE SID=<your ORACLE SID>”. You can check that this variable is active
by typing “echo $ORACLE sSID”. You should see your ORACLE_SID displayed.

Set environment variable NLS_LANG to: <LANGUAGE> <TERRITORY>.UTF8. Here <LANGUAGE> is
used for Oracle messages, day names, and month names. <TERRITORY> specifies conventions
for default calendar, monetary, numerical format. For example, if in USA, you can set the
parameter to AMERICAN AMERICA.UTF8. For more information on NLS_LANG see the Oracle
National Language Support Guide.

Change to the <otm install path>/glog/oracle/script8 directory on the Oracle
Transportation Management application server.

Create database users and schemas by running create all script. This process is run at the
host command line; Two command scripts are provided and the script you use is dependent
on your operating system:

UNIX shell script:

./create all.sh

or

Windows command line script:
create all.cmd

Enter database connection ID, SYS user password, DBA user name that can create users
(other than SYS user), password, partition preference, and property file location information
when prompted.

After the process has run, verify in the create all <dbsid> <timestamp>.log file (located in
the same directory as source) that there are no errors. Contact Technical Support if you find
any errors like "ORA-" or “Package Body created with compilation errors”.

Also review the log file called import content <dbsid> <timestamp>.log for errors (located
in the same directory as the SQL script). Look for errors by searching key words like "ORA-",
“Caught exception”,”SP2-", or “<Error>" within the log file. Contact Technical Support if you
find any errors.

In SQL*Plus, as user GLOGOWNER run:
@ag_setup.sqgl

In SQL*Plus, as user GLOGOWNER run:
@recompile invalid objects.sql

After running the recompile_invalid_objects.sql script, you should see the following on the
screen:

Invalid objects after Recompile..
0

If the number of invalid objects is not zero, run the recompile invalid objects.sqgl script
again. If you still have invalid objects after the second run, copy the script output from the
command prompt window, paste into a text file, and forward it to Technical Support.

Reset Sequences

1.

In SQL*Plus as the GLOGOWNER user, run:

Set serverout on size 1000000
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Execute domainman.reset sequence;

Verify Database Structure

1. Change to the <otm _install path>/gc3/glog/oracle/script8 directory on the Oracle
Transportation Management application server.

2. In SQL*Plus, as user GLOGOWNER run:

Select count (*)

"BINSS' ;

The result should be:

COUNT (*)
0

3. Run:

Select namespace from dba context where schema

The result should be:

NAMESPACE
GL_USER_CTX

4, Run:

select object owner,

where object owner in

group by

object owner;

The result should be:

OBJECT_OWNER | COUNT(*)

GLOGOWNER 13250
REPORTOWNER 138
5. Run:

@object count.sql

count (*)

from all objects where status=’INVALID’
(" GLOGOWNER’ , " REPORTOWNER' , * GLOGDEV’ , " GLOGLOAD" )

For partitioned database the results should be:

OWNER OBJECT_TYPE TOTAL
ARCHIVE LOB 5
SEQUENCE 356
TABLE 356
GLOGDEV TRIGGER 1
3-6 Copyright © 2001, 2012, Oracle and/or its affiliates. All rights reserved.

and owner in
and Object name not like

" GLOGOWNER’ ;

from dba policies
("GLOGOWNER', 'REPORTOWNER ")




OWNER OBJECT_TYPE TOTAL

GLOGLOAD TRIGGER 1
GLOGOWNER FUNCTION 8178
INDEX 3290

INDEX PARTITION 73

JAVA CLASS 10
JAVA SOURCE 7
LOB 42
LOB PARTITION 61
PACKAGE 69
PACKAGE BODY 67
QUEUE 3
SEQUENCE 232
TABLE 1639

TABLE PARTITION 461

TRIGGER 3710
TYPE 4
VIEW 25
REPORTOWNER | INDEX 15
PACKAGE 80
PACKAGE BODY 80
SEQUENCE 1
TABLE 15
TRIGGER 16
VIEW 33

For non-partitioned database the results should be:
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OWNER OBJECT_TYPE TOTAL
ARCHIVE LOB 5
SEQUENCE 356
TABLE 356
GLOGDEV TRIGGER 1
GLOGLOAD TRIGGER 1
GLOGOWNER FUNCTION 8178
INDEX 3290
JAVA CLASS 10
JAVA SOURCE 7
LOB 42
PACKAGE 69
PACKAGE BODY 67
QUEUE 3
SEQUENCE 232
TABLE 1639
TRIGGER 3710
TYPE 4
VIEW 25
REPORTOWNER | INDEX 15
PACKAGE 80
PACKAGE BODY 80
SEQUENCE 1
TABLE 15
TRIGGER 16
VIEW 33

If your results differ from those shown above, contact Technical Support.
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Installing the Replicated Operational Database for Reporting and
Archiving

A Replicated Operational Database (ROD) is a replicated version of your OLTP database (except for
CLOB and LONG columns), on a completely separate database. It is created using Oracle’s
materialized view technology. The ROD is intended for users who need to run reports or long-running
queries. Separating the reporting from the online transaction processing ensures that reports do not
adversely affect performance of the OLTP database.

Once you create the new database for storing the ROD, ensure that the database initialization
parameters are similar to the OLTP database (such as the character set). The ROD does not use
partitioning, since CLOB columns are not copied over.

Creating Materialized View Logs on the OLTP

Log files are needed to capture updates, inserts, and deletes on the OLTP database, so that the ROD
database can be refreshed incrementally. Run the following to install the logs onto the OLTP database.

1. On the OLTP database as GLOGOWNER run the following.

@create mview logs

2. On the OLTP database as REPORTOWNER run the following.

@create mview logs

Create Tablespaces

3. To create the tablespaces for the ROD, run the following. It is the same script for creating
tablespaces on the OLTP, but enter Y when asked if this is the ROD database. If archiving is
going to be stored on the ROD also, enter Y when prompted.

@create gc3 tablespaces

Note: The ROD, without archiving, will be smaller than the OLTP, since the ROD is a replica
of the OLTP database without the LONG or CLOB columns (key tablespaces for the ROD is
DATA and INDX). If archiving is stored on the ROD database, then this will be stored in the
ARCHIVE tablespace.

Configure TNS Names on ROD Database Server

4. On the ROD database server, configure your tnsnames.ora file to have an entry for your OLTP
database. You will be prompted for the connection ID later when the database link is created.

Create Database Roles and Database Users
5. On the ROD database as user SYS run the following:

@create glog users.sql

The database users created have their passwords the same as their user ID, respectively.
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Create Database Links

6. The two databases now need to ‘see’ each other, so that the ROD can be refreshed from the
OLTP, and logging information from the ROD can be written back to the OLTP. Visibility will be
accessed through database links. Run the following scripts (you will be immediately
reconnected as GLOGOWNER on the appropriate database (OLTP or ROD) once you have
entered the proper parameters, so who you are initially connected as is not a concern.)

@create dblink rod to oltp.sql

7. You should see SUCCESS in the feedback after the creation of each link, as it is tested. If you
see an error, then do not continue until this step is successful, as the next steps rely on the
links.

Note: If you change the passwords for your databases, rerun the database link creation
scripts so that the links use the correct passwords. Otherwise, use of the links will produce
an invalid username/password error.

Initialize the ROD database

8. To populate the ROD, run the following step.

@create rod.sql

It will connect as GLOGOWNER and create and populate the materialized views. This step will take
several hours or days. Once the ROD is initially set up, it will be updated incrementally through the
use of the logs.

This will prompt you for:

e the ROD connection string
Modify Refresh Time

In the previous step, the materialized views created were grouped into following refresh groups.

AA

SHIPMENT
OB_ORDER_BASE
ORDER_RELEASE
INVOICE

S _SHIP UNIT
INTEGRATION
COMMON _ xx

Here xx in COMMON_xx stands for 1, 2, 3, ...

The refresh schedule for the groups has been set as below:

GROUP INITIAL REFRESH INTERVAL BETWEEN REFRESHES
AA SYSDATE + 1 Every 15 minutes
All other groups SYSDATE + 1 Every one day

If you want to change the refresh interval you can call pkg_refresh.make_refresh_group procedure.
This procedure accepts four parameters:

e Group name
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e Initial time the refresh job should begin
e defaults to TRUNC(SYSDATE)+1

e when ROD is initially created, it is set to TRUNC(SYSDATE)+5 so that the refresh does not
occur during initial setup (i.e. 5 days from 12am of current day)

e Interval of time between refresh jobs
e defaults to ‘SYSDATE+1’ which means to run the refresh job once a day

Note: Even the default is once a day for AA group, you should set it to much shorter
interval if you have Advance Analysis runs in this ROD database, like every 15 minutes.

Note: The initial time to run is a date, but the interval is a string.
Examples:
EXEC PKG_REFRESH.MAKE_REFRESH_GROUP(P_GROUP_NAME =>'SHIPMENT'"); --for SHIPMENT
group, uses all defaults, which means set initial refresh time to be 12am the next day, refresh every
day, with no parallelism.
OR
EXEC PKG_REFRESH.MAKE_REFRESH_GROUP(P_GROUP_NAME =>'AA', P_INITIAL_TIME =>
trunc(sysdate)+2); --for AA group, initially starts refresh 2 days from now at 12am, and refresh once
a day (default)
OR
EXEC PKG_REFRESH.MAKE_REFRESH_GROUP(P_GROUP_NAME =>'AA',P_INITIAL_TIME =>
trunc(sysdate)+5, p_interval => 'SYSDATE+15/24/60"); -- for AA group, starting 5 days from now at
12am, refreshes every 15 minutes, with a parallelism setting of 3.
You can verify the settings by querying the view DBA_REFRESH.

Note: The DBA should check the alert log for any potential errors on a daily basis.
It is recommended to run the refresh during off-peak hours, since reports should not be run while the

refresh process is occurring. It does not cause errors, but would cause potential report integrity
problems, since some tables might have been refreshed, while others may not have completed.

Archive Setup

Oracle Transportation Management can store archived orders and shipments on your transactional
(OLTP) database, or on the Replicated Operational Database (ROD) used for reporting.

If you do not have an ROD set up, but plan to (and want archiving stored there), you can create the
separate database and follow the initial ROD steps of:

e Create Tablespaces
e Configure TNSNames
e Create Database Roles and Users

Run the following to create the ARCHIVE user and ARCHIVE tablespace on the database that will store
archiving (should be your OLTP or the ROD). This step can be skipped if you already have the archive
user. As the user SYSTEM, run the following:

@create archive user.sql
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If archiving will be stored on the ROD, run the following as GLOGOWNER on your OLTP (if you have
not already done so as part of ROD installation):

@create _dblink oltp to_rod.sql

Then, on the ROD, run the following as GLOGOWNER (if you have not already done so as part of ROD
installation):

@create _dblink rod to_oltp.sql

Run the following to set up the archive triggers and tables from the OLTP as GLOGOWNER. If the
tables already exist from prior versions, this step will ensure they are in sync with the Oracle
Transportation Management table structures.

@create archive objects.sql

The upgrades/patches will automatically keep the archive objects in sync as new tables and columns
are added.

Moving Archiving from OLTP to ROD

Initially, archiving gets implemented on the OLTP database, you can move it to the ROD database.
You will need the following to move archiving from OLTP to ROD database.

e Export the archive schema

e Login to OTLP database as system and run ‘drop user archive cascade’

e Run @create_archive_user.sqgl on the ROD as glogowner

e Import archive schema onto the ROD database

e Create database links as described below:
o Login to OTLP as glogowner and run @create_dblink_oltp_to_rod
o Login to ROD as glogonwer and run @create_dblink_rod_to_oltp

e Login to ROD as glogowner and run @create_archive_objects.sql which will recreate the
triggers and set up grants.
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4. Installing Oracle Fusion Transportation Intelligence (FTI)

Oracle Transportation Management delivers the Oracle Fusion Transportation Intelligence (FTI)
solution that includes the following components. For more details about these components and Oracle
Fusion Transportation Intelligence, see the Oracle Fusion Transportation Intelligence Reference Guide.

e Oracle Fusion Transportation Intelligence Extract Transform & Load (ETL): Pre-packaged ETL
process that needs to be deployed on an Oracle Data Integrator (ODI) instance

e Oracle Fusion Transportation Intelligence Historical Database (HD): The analytics database for
the Oracle Fusion Transportation Intelligence application

e Oracle Fusion Transportation Intelligence Metadata: Delivered as advanced_analytics.rpd file
e Oracle Fusion Transportation Intelligence Canned Reports: Delivered as aa_webcat.zip
Oracle Fusion Transportation Intelligence installation steps are detailed further in this chapter.

Installing Oracle Fusion Transportation Intelligence Historical
Database (HD)

Preparing Oracle Transportation Management Database for Transportation
Intelligence

Operational Database

Log on to the Oracle Transportation Management OLTP database as glogowner. Run the following
script from the directory -

<otm_install path>/glog/oracle/script8/advanced analytics directory.
load status script.sqgl

This script loads the new READY_TO_LOAD status to all shipments, order bases, and order releases in
Oracle Transportation Management. This may take time depending on how many business objects are
in the database. This also loads the status of NOT_READY_TO_LOAD for these objects.

Replicated Operational Database (ROD) Considerations

The deployment architecture of Oracle Fusion Transportation Intelligence supports the following
deployment choices for customers:

1. Load Historical Database using ROD

In this deployment, a ROD (that maintains a snapshot of the Oracle Transportation
Management OLTP database) is used. The Oracle Fusion Transportation Intelligence ETL jobs
will connect to the ROD to load the Historical Database thereby de-coupling the Oracle
Transportation Management OLTP database from the ETL process.

2. Load Historical Database using OLTP (Online Transaction Processing Database)

In this deployment, the Oracle Fusion Transportation Intelligence ETL jobs will connect directly
to the Oracle Transportation Management OLTP database to load the Historical Database
adding to additional database workload on the Oracle Transportation Management OLTP
database

We strongly recommend you use an ROD to achieve performance gains and to efficiently balance the
load on the Oracle Transportation Management OLTP database.
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Historical Database (HD) Considerations

The Historical Database (HD) schema can be created on a separate database beginning with Oracle
Transportation Management 6.2. This schema can also share the ROD or the OLTP database.

Create Historical Database (HD), Users, and Packages

Note: You may have to execute the create aa tablespaces.sgl as SYS user to create
the tablespaces required for the HD. This script is available under
<otm_install path>/glog/oracle/script8/advanced analytics.

Note: The create aa all.sqgl explained below calls the CSV load utility. This utility
obtains the details of an Oracle Fusion Transportation Intelligence database from the
glog.properties file.

The connection details for Oracle Fusion Transportation Intelligence are requested during
the Oracle Transportation Management installation. If you did not enter any values at the
time of installation, you have to modify the glog.properties file and modify the necessary
properties.

1. Log into the database (as per your deployment architecture discussed above) where you want
to install Oracle Fusion Transportation Intelligence as SYS user.

2. Run the following script from a SQL prompt:
<otm_install path>\glog\oracle\script8\advanced analytics\create aa all.sql

3. Enter your Connection ID to the Oracle Fusion Transportation Intelligence Historical Database
(HD) when prompted.

4. Enter SYS user password for Oracle Fusion Transportation Intelligence database to login as

sysdba.

Enter GLOGOWNER user password of your OLTP database.

Enter Connection ID to the OLTP database when prompted.

Enter Y or N depending on machine type (UNIX or Windows)

Enter path of directory where glog.properties file is located.

After the process has run, verify in the create_aa_all.log file that there are no errors. Contact
Technical Support if you find any errors like "ORA-" or “Package Body created with compilation
errors”. Also verify that csvone_aa_W_LOCALIZED_STRING_G.log file does not have any
errors like "ORA-", “"Caught exception”,”SP2-", or “<Error>". Contact Technical Support if you
find any other errors.

© ® N oG

This step will now create the hdowner user, tables, MViews, packages etc.

Installing Oracle Data Integrator (ODI)

Refer to the Oracle Data Integrator Installation Manual for detailed instructions on how to install
Oracle Data Integrator. The minimum settings required for installing Oracle Data Integrator for Oracle
Fusion Transportation Intelligence are listed below.

Certain files required for Oracle Data Integrator installations are available under
<otm install path>/fti. If Oracle Data Integrator is installed on a different server, please copy
these files to a folder where the installing user has write permissions.

If you are installing Oracle Data Profiling and/or Oracle Data Quality for Oracle Data Integrator, you
will be asked to configure the Metabase servers and to define for the client the Metabase to which you
will connect. Ignore this step if you do not install Oracle Data Profiling or Oracle Data Quality for
Oracle Data Integrator.
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Execute ./runInstaller in Linux or setup.bat in Windows to start the ODI install.

On UNIX platforms add the following environment variables for the user who has installed
Oracle Data Integrator:

ODI_JAVA HOME=<ODI_HOME>/jre/1.4.2
TS QUALITY=<ODI HOME>/oracledqg/quality server/tsqgllr5s/Software
LD LIBRARY PATH=<ODI_HOME>/oracledq/quality server/tsqllr5s/Software/bin

Configuring ODI for Oracle Fusion Transportation Intelligence ETL

Creating the Master Repository

Creating the master repository consists of creating the tables and the automatic importing of
definitions. To create the master repository:

1.

3.

In the Start Menu, select Programs > Oracle Data Integrator > Repository Management
> Master Repository Creation, or launch bin/repcreate.bat Or bin/repcreate.sh.

Complete the fields:
e Driver: oracle.jdbc.driver.OracleDriver

e URL: The complete path for the data server to host the repository. For example:
jdbc:oracle:thin:@<FTI DB IP ADDRESS>:1521:<FTI DB CONNCET STRING>

e User: ftimaster (i.e master repository schema user).
e Password: ftimaster (i.e master repository schema user’s password).

e ID: A specific ID for the new repository. Do not use the defaults of 0 and try to choose a
number greater than 100. Always remember to choose different numbers for the
development, QA, User Acceptance, and production environments. This will affect imports
and exports between repositories.

e Technology: From the list, choose Oracle.
Click OK to begin master repository creation.

Connecting to the Master Repository

To connect to the Master repository:

1.

2.
3.

In the Start Menu, select Programs > Oracle Data Integrator > Topology Manager, or
launch the Topology Manager script (bin/topology.bat or bin/topology.sh).

Click New (first button to the right of the Login Name field).
Complete the following fields:

Oracle Data Integrator Connection:

e Login name: A generic alias (for example: DEVMASTER)
e User: SUPERVISOR (use capitals)
e Password: SUNOPSIS (use capitals)

DBMS Connection (Master Repository):

e User: ftimaster (i.e. login of the owner of the tables you have created for the master
repository)

o Password: ftimaster (ftimaster’'s password)
e Drivers' List: choose Oracle JDBC Driver

e URL: The complete JDBC URL for the master repository data server. For example:
jdbc:oracle:thin:@<FTI DB IP ADDRESS>:1521:<FTI DB CONNCET STRING>
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1.
2.
3.

Click on Test to check the connection is working.
Click OK.
Click OK to validate.

Importing the Master Repository

The user completing this step must have write access to the folder that contains the files
FTI _ETL MASTER.zip, FTI ETL SECURITY.zip, and FTI_ETL WORK.zip.

1.
2.
3.

8.

Connect to the Master Repository as described above.

Select File > Import > Master Repository.

Complete the fields:

e Import Mode: choose Synonym Mode INSERT_UPDATE.

e Select Import From a Zip File.

¢ Choose <otm_install path>/fti/etl/odi/FTI_ETL_MASTER.zip.

Click OK to import the master repository. This process may take up to 20 minutes.
Validate the JDBC URLs for source and target database JDBC URLs.

Go to the Physical Architecture tab and expand Technologies > Oracle. We have the
following physical schemas.

e ORACLE_FTI: (QA or PROD or UAT) Environment’s Historical Database hdowner schema
mapped to global context.

e ORACLE_FTI_DEV: Development Environment’s Historical Database hdowner schema
mapped to development context.

¢ ORACLE_OTM: (QA or PROD or UAT) Environment’s Oracle Transportation Management
glogowner schema mapped to global context.

e ORACLE_OTM_DEV: Development Environment’s Oracle Transportation Management
glogowner schema mapped to development context.

Double-click on each one of above-mentioned schema and go to JDBC tab and enter
corresponding JDBC URL.

Note: On the Definition tab’s connection section, you must use the FTISTAGE credentials
for ORACLE_FTI/ORACLE_FTI_DEV data servers. For ORACLE_OTM/ORACLE_OTM_DEV
data servers you must use glogdba credentials.

Click on Test to test the connection.

Creating the Work Repository

To create a work repository:

1. Connect to your master repository through the Topology module. For more information, refer
to the Connecting to the Master Repository section.

2. Navigate to Topology > Repositories > Work Repositories in the icon list.

3. Right-click and select Insert Work Repository. A window appears asking you to complete
the connection parameters for your work repository.

4. In the connection window, complete the following parameters:
¢ Name: Type the name for your work repository connection. For example, DEV_FTI WORK.
e Technology: Chose Oracle.
e User: ftiwork (i.e User ID/login of the owner of the tables you are going to create and

host of the work repository).
e Password: ftiwork (i.e This is the user's password).
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9.

Click the JDBC tab and complete the following fields:
e JDBC Driver: Choose Oracle JDBC Driver

e URL JDBC: The complete JDBC URL for the master repository data server. For example:
jdbc:oracle:thin:@<FTI DB IP ADDRESS>:1521:<FTI DB CONNCET STRING>

Click Test.

Note: Do not attempt to close this window by clicking OK if you haven't tested your
connection properly.

Click OK to validate the parameters for connecting to the server which will host your work
repository. A window appears asking you to give a unique name and user ID code number to
your repository.

In the Work Repository window, complete the following parameters:

e ID: Give a unique number to your repository, from 1 to 500.

« Name: Give a unique name to your work repository. For example, DEV_FTI WORK.
e Type: Choose Development in the list.

Note: Please fill Name with alphanumeric characters only. Don’t use special characters and
space bar and take note of it, so that you can use it for the value of
glog.odi.work.repository.code property in glog.properties file.

Click OK to validate. The creation of your work repository begins.

When the work repository has been created, the Work Repository window closes. You can now access
this repository through the Designer and Operator modules. For more information, refer to the
Connecting to the Work Repository section.

Connecting to the Work Repository

To connect to a work repository and launch the Designer module:

1.

2.
3.

In the Start Menu, select Programs > Oracle Data Integrator > Designer, or launch the
Designer script (bin/designer.bat Or bin/designer.sh).

Click on the New button (first button to the right of the Login Name field).
Complete the following fields:

Oracle Data Integrator Connection:

e Login Name: A generic alias. For example: Repository
e User: SUPERVISOR (capitalized)
e Password: SUNOPSIS (capitalized)

DBMS connection (Master Repository):

e User: ftimaster (This is the login of the owner of the tables you have created for the
master repository. This is not the login for the work repository).

e Password: ftimaster. This is the user's password.
e List of Drivers: Choose Oracle JDBC Driver

e URL: The complete JDBC URL for the master repository data server. For example:
jdbc:oracle:thin:@<FTI DB IP ADDRESS>:1521:<FTI DB CONNCET STRING>

Work Repository:

¢ Work Repository Name: The name you gave your work repository in the previous step
(DEV_FTI_WORK in the example). You can display the list of work repositories available in
your master repository by clicking on the button to the right of this field.
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4. Click Test to check that the connection is working.
5. Click OK. The Designer module opens.

Importing Security

Connect to the work repository as described above.
Open the Security Manager by clicking on Security Manager icon.
In the Security Manager, select File > Import > Security Settings.
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Complete the fields:

e Import Mode: choose Synonym Mode INSERT_UPDATE.

e Select Import From a Zip File.

e Choose <otm_install_path>/fti/etl/odi/ FTI_ETL_SECURITY.zip.
5. Click OK to import the security settings. This process may take few minutes.

Importing the Work Repository

1. Connect to Work Repository as described above.
2. From Designer, select File > Import > Work Repository.
3. Complete the fields:
e Import Mode: choose Synonym Mode INSERT_UPDATE.
e Select Import From a Zip File.
e Choose <otm_install path>/fti/etl/odi/ FTI_ETL WORK.zip.

4. Click OK to import the work repository. This process may take up to 40 minutes. Do not close
or kill the process.

Starting the Oracle Data Integrator Agent Process

1. Start the Oracle Data Integrator agent by running bin/agent.sh on UNIX or bin/agent.bat
on Windows. Append an "&” at the end of a command to run in the background process.

Configuring Oracle Transportation Management for Oracle Fusion
Transportation Intelligence ETL

1. After successfully installing and configuring ODI for FTI ETL, next configure the ODI-related
properties in Oracle Transportation Management. Refer to the Oracle Transportation
Management Properties portion of the Configuring Oracle Transportation Management for
Oracle Fusion Transportation Intelligence section for details.

Scheduling through Oracle Transportation Management Process Management

Log into Oracle Transportation Management.
Go to Transportation Intelligence > Process Management > Load Data to HD.
Schedule/Run the Load Data to HD process.
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. Check the logs for errors.

Installing Oracle Business Intelligence Enterprise Edition (OBIEE)

For detailed installation steps of OBIEE on your preferred operating system, please refer to the
corresponding OBIEE installation documentation.

Runtime deployment of OBIEE requires the availability of a web application server (0OC4], WebLogic,
Apache TomCat, etc.). The OBIEE installation includes OC4] installation and Oracle Fusion
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Transportation Intelligence is officially certified only for OBIEE deployed using OC4J. Therefore we
strongly recommend you to opt for OC4] component during the OBIEE installation.

If you need to use a web application server of your choice, then please refer the OBIEE documentation
for the compatibility of OBIEE on your choice of web application server and also for detailed
deployment instructions.

Please make note of the following information during the course of the OBIEE Installation.

e The Administrator Login’s password for OC4]

e The OBIEE root directory <OBIEE Root Dir> = <OBIEE Install Dir>/OracleBI (Example: If we
installed OBIEE in opt/OBIEE then <OBIEE Root Dir> = opt/OBIEE/OracleBI)

e The OBIEE data directory <OBIEE Data Dir> = <OBIEE Install Dir>/OracleBIData (Example:
If we installed OBIEE in opt/OBIEE then <OBIEE Data Dir> = opt/OBIEE/OracleBIData)

We describe the server where OBIEE is installed as the OBIEE Server in the subsequent chapters.

Post-installation Steps for Fusion Transportation Intelligence on OBI
EE 10.1.3.4.x

If you have successfully installed OBI EE, this chapter details the steps to deploy the Oracle Fusion
Transportation Intelligence components (metadata & reports) and the various other configurations to
be done in OBI EE and Oracle Transportation Management to complete the Oracle Fusion
Transportation Intelligence deployment. Please perform the configuration steps in the sequence below.

1. Copy the following files from the Oracle Transportation Management application server to the
server where OBI EE was installed for Fusion Transportation Intelligence.

From the < 0TM Home >/fti directory copy these files:

e palette.cxml
e portallogo.gif
¢ smartway-logo.jpg - only needed for OTM 6.0 and above
e aa_webcat.zip
e advanced_analytics.rpd
2. Use the following commands to copy the FTI files in to place on your OBI EE instance.

export OBIEE INSTALL=<OBIEE Install Dir>
export OBIEE DATA=<OBIEE Data Dir>

Note: The entries would look similar to this:

export OBIEE INSTALL=/opt/home/otmora/obiee/OracleBI

export OBIEE DATA=/opt/home/otmora/obiee/OracleBIData

cp advanced analytics.rpd S$OBIEE INSTALL/server/Repository

cp aa webcat.zip $SOBIEE DATA/web/catalog

cp palette.cxml $OBIEE INSTALL/web/app/res/s_oraclelO/chartsupport
cp portallogo.gif SOBIEE INSTALL/web/app/res/s_oraclelO/portal

cp smartway-logo.jpg $SOBIEE INSTALL/web/app/res/s_oraclel(l/images
unzip SOBIEE DATA/web/catalog/aa webcat.zip

3. In the OBI EE server, create a new database connection with the name “"RPTAPP” ONLY in the
tnsnames.ora file. This database connection should connect to the Oracle Fusion
Transportation Intelligence Historical Database. When OBIEE loads the Oracle Fusion
Transportation Intelligence metadata, it will connect to the HD using the ‘RPTAPP’ database
connection only.
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RPTAPP =
(DESCRIPTION =
(ADDRESSiLIST =
(ADDRESS = (PROTOCOL = TCP) (HOST ="yourDBserver.com”) (PORT = 1521))
)
(CONNECT DATA =
(SID = “yourDBsid”)
)
)

4. In the <OBIEE Install Dir>/server/Config directory, edit the NQSConfig.INI as follows:
a. Comment out the following line by putting a “#” in front of it:
Star = samplesales.rpd, DEFAULT;

b. And add the following line:
Star = advanced analytics.rpd, DEFAULT;

c. In the [CACHE] section, set the ENABLE property to 'YES' or 'NO to turn ON or OFF the
OBIEE Server 'Query Cache'.

By default the ENABLED property is set to TRUE.
d. Comment out the following line by putting a “#” in front of it:
ENABLE = YES;

e. And add the following to turn off Query Cache.
ENABLE = NO;

5. In the <OBIEE Data Dir>/web/config/ directory, edit the instanceconfig.xml as follows:

a. Change the CatalogPath to point the new “aa” directory that was created when you
extracted the aa_webcat.zip file. The template shows the following line.

<CatalogPath><OBIEE Data Dir>/web/catalog/aa</CatalogPath>

Note: Do not put in the <OBIEE Data Dir>; only add the reference to the “aa”
directory.

The entry will look like this:
<CatalogPath>/opt/oraclebi/oraclebidata/web/catalog/aa</CatalogPath>

b. In the same file, add the following XML tag after the
<BIforOfficeURL>..</BIforOfficeURL> XML tag.

Using this XML tag you can specify the maximum allowed dropdown values. OBI EE

looks for the following entry in the file:
<BIforOfficeURL>client/OracleBIOffice.exe</BIforOfficeURL>

c. And add this after it:

<Prompts>
<MaxDropDownValues>1500</MaxDropDownValues>
</Prompts>

d. So the file will look like this when you’re done.
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<BIforOfficeURL>client/OracleBIOffice.exe</BIforOfficeURL>
<Prompts>

<MaxDropDownValues>1500</MaxDropDownValues>
</Prompts>

e. After the following line you need to add information to point to the
credentialstore.xml file:

A
<Disconnected><ArchivelIbots>true</Archivelbots><DisconnectedDir>disco
nnected</DisconnectedDir></Disconnected> —-->

f. Add the following tags:

<CredentialStore>

<CredentialStorage type="file" path="<OracleBI Data
Dir>/web/config/credentialstore.xml" passphrase="another secret"/>
</CredentialStore>

Note: Be sure to change the <OracleBI Data Dir> to your instances actual Oracle
BI Data Directory. Your entry should look similar to this.

<CredentialStore>

<CredentialStorage type="file"
path="/opt/home/otmora/obiee/OracleBIData/web/config/credentialstore.xm
1" passphrase="another secret"/>
</CredentialStore>

g. After the </CredentialStore> tag add the following:

<Auth>
<SSO enabled="true">
<ParamList>

<Param name="IMPERSONATE" source="serverVariable"
nameInSource="REMOTE USER"/>
</ParamList>
<LogoffUrl>http://{0OTM-WEBSERVER}</LogoffUrl>
<LogonUrl>http://{0OTM-WEBSERVER}</LogonUrl>
</SS0O>
</Auth>

Note: Be sure and set the LogoffUrl and LogonUrl to the URL for the Oracle
Transportation Management webserver. A typical entry will look like this:

<Auth>
<SSO enabled="true">
<ParamList>

<Param name="IMPERSONATE" source="serverVariable"
nameInSource="REMOTE USER"/>
</ParamList>
<LogoffUrl>http://otm-instance.yourcompany.com</LogoffUrl>
<LogonUrl>http://otm-instance.yourcompany.com</LogonUrl>
</SS0>
</Auth>

h. Save the changes.
6. Go to the <OBIEE Install Dir>/setup directory and edit the user.sh file as follows:
a. Look for the section specific to your operating system
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FHAH AR A AR AR AR A A AR A AR AR A AR AR AR AR AR A AR AR A AR A RS S
# Linux: Oracle BI 32 bit mode

FH A A A R AR A R AR R RS
#set +u

# Oracle Parameters

# Make sure that Oracle DB 32 bit Client is installed
#ORACLE HOME=/export/home/oracle/10g

#export ORACLE HOME

#TNS_ADMIN=$ORACLE HOME/network/admin

#export TNS_ ADMIN
#PATH=SORACLE_HOME/bin:/opt/bin:S$PATH

#export PATH

#LD LIBRARY PATH=SORACLE HOME/lib:$LD LIBRARY PATH
#export LD LIBRARY PATH

# If you have Linux 64 bit Platform, and would like to run Oracle BI
32 bit

# then you must install Oracle DB 64 bit client, and this client
comes with

# 32 bit libraries under SORACLE HOME/1ib32. The LD LIBRARY PATH in
this case

# shall be like this:

#LD LIBRARY PATH=S$ORACLE HOME/1ib32:$LD LIBRARY PATH

#export LD LIBRARY PATH

Remove the # from the beginning of the lines. Be sure to uncomment the additional
lines if using a 64 bit client.

FhAH A
# Linux: Oracle BI 32 bit mode
izttt st R EE
fset +u

# Oracle Parameters

# Make sure that Oracle DB 32 bit Client is installed
ORACLE_HOME=/u0l/app/oracle/product/1020

export ORACLE HOME

TNS_ ADMIN=$ORACLE HOME/network/admin

export TNS ADMIN

PATH=SORACLE_HOME/bin:/opt/bin:$PATH

export PATH
LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
export LD LIBRARY PATH

# If you have Linux 64 bit Platform, and would like to run Oracle BI
32 bit

# then you must install Oracle DB 64 bit client, and this client
comes with

# 32 bit libraries under $ORACLE_HOME/lib32. The LD LIBRARY PATH in
this case

# shall be like this:
#LDiLIBRARYiPATH=$ORACLEiHOME/lib32:$LD7LIBRARY7PATH

#export LD LIBRARY PATH

Save the changes.
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Encrypt credentialstore.xml.

Critical user credentials information is stored in the <OBIEE Data
Dir>/web/config/credentialstore.xml file. This file needs to be encrypted for security
reasons.

To encrypt the contents of this file, please follow the steps listed below:

a. Log onto the OBI EE server as the user that will be running the OBI EE processes.

b. Set up the users environmental variables by going to the <OBIEE Install
Dir>/setup directory and running the following scripts:

../user.sh
../sa-init.sh

c. Go tothe <OBIEE Install Dir>/web/bin directory and run the following command:

cryptotools credstore -add -infile <OracleBIData
Dir>/web/config/credentialstore.xml

Note: Be sure and set the <OracleBIData Dir> to the correct directory. A typical
entry will look like this:

cryptotools credstore -add -infile
/opt/home/otmora/obiee/OracleBIData/web/config/credentialstore.xml

d. The following will be displayed on the screen. The expected responses are in bold:

Credential Alias: impersonation

Username: Impersonator

Password: secret

Do you want to encrypt the password? y/n (y): Y

Passphrase for encryption: another_secret

Do you want to write the passphrase to the xml? y/n (n): N

OBl EE Scheduler Configuration

In the OBI EE Server, to configure the OBI EE Scheduler services for iBots follow the steps below.

1.

From the OBI EE server, go to the <OBIEE Install Dir>/server/Bin directory and execute the
schconfig script listed below:

./schconfig

The following information will be displayed. Enter the information specified for each section

listed:

Copyright (c) 1997-2006 Oracle Corporation, All rights reserved
*x*%* Delivers Configuration Menu ***x*

1

O Ul W N

>>>

Configure Scheduler
Configure Mail

Configure iBots
Configure Workflow
Configure Java Extension
Quit

Enter Choice

a. Enter 1 and press Enter.

The following information is displayed.
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*x*%% Scheduler Configuration ****x*
1 - Database

2 — General

3 - Advanced

0 - Quit

b. Enter 1 and press Enter.

The following information is displayed.

**x*x%% Scheduler Database Configuration *****

- Database Type

- Call Interface

- Data Source Name

- User Name

- Password : *****

- Timeout (Minutes) : 60

- Maximum Connections : 5

- Bulk Fetch Buffer Size (bytes) : 33792

- Database Table for Jobs : S NQ JOB

10 - Database Table for Instances : S NQ INSTANCE
11 - Database Table for Parameters : S NQ JOB PARAM
12 - Database Table for Messages : S NQ ERR MSG
13 - DEFAULT VALUES

0 - Quit

O J o) U WwN

Ne]

c. Enter 1 and press Enter.

The following information is displayed.

**%x* Database Type *****
01 - Oracle 10g R2

02 - Oracle 10g R1

03 - Oracle 9i

04 - Oracle 8i

05 - DB2 0S/390 V7

06 - DB2 0S/390 V8

07 - DB2 UDB V7

08 - DB2 UDB V8/V9

d. Enter 01 and press Enter.

The following information is displayed.
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**x*x%% Scheduler Database Configuration *****

1 - Database Type : Oracle 10g Rl

2 - Call Interface

3 - Data Source Name

4 - User Name

5 - Password : ****%

6 - Timeout (Minutes) : 60

7 - Maximum Connections : 5

8 - Bulk Fetch Buffer Size (bytes) : 33792

9 - Database Table for Jobs : S NQ JOB

10 - Database Table for Instances : S NQ INSTANCE

11 - Database Table for Parameters : S NQ JOB PARAM
12 - Database Table for Messages : S NQ ERR MSG

13 - DEFAULT VALUES

0 - Quit

e. Enter 2 and press Enter.

The following information is displayed.

*xx4k*% Enter Call Interface *x**x*
01 - ODBC 2.0

02 - ODBC 2.01

03 - ODBC 3.5

04 - OCI 8i/9i

05 - OCI 10g

f. Enter 05 and press Enter.

The following information is displayed.

*x*x%* Scheduler Database Configuration *****

1 - Database Type : Oracle 10g R1

2 - Call Interface : OCI 10g

3 - Data Source Name

4 - User Name

5 - Password : *****

6 - Timeout (Minutes) : 60

7 - Maximum Connections : 5

8 - Bulk Fetch Buffer Size (bytes) : 33792
9 - Database Table for Jobs : S NQ JOB

10 - Database Table for Instances : S NQ INSTANCE
11 - Database Table for Parameters : S NQ JOB PARAM
12 - Database Table for Messages : S NQ ERR MSG

13 - DEFAULT VALUES

0 - Quit

g. Enter 3 and press Enter.
h. Enter RTAPP for your data source name and press Enter.

The following information is displayed.
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**x*x%% Scheduler Database Configuration *****

- Database Type : Oracle 10g R1

- Call Interface : OCI 10g

- Data Source Name : RPTAPP

- User Name

- Password : **x**x

- Timeout (Minutes) : 60

- Maximum Connections : 5

- Bulk Fetch Buffer Size (bytes) : 33792
Database Table for Jobs : S NQ JOB

- Database Table for Instances : S NQ INSTANCE
11 - Database Table for Parameters : S NQ JOB PARAM
12 - Database Table for Messages : S NQ ERR MSG
13 - DEFAULT VALUES

0 - Quit

O J o U w N

= o
o
|

i. Enter 4 and press Enter.
j. Enter hdowner for the user name and press Enter.

The following information is displayed.

***x*x*x Scheduler Database Configuration ****x*
- Database Type : Oracle 10g R1

- Call Interface : OCI 10g

- Data Source Name : RPTAPP

- User Name : hdowner

- Password : **x**xx*

- Timeout (Minutes) : 60

- Maximum Connections : 5

~ o U b W DN

8 - Bulk Fetch Buffer Size (bytes) : 33792

9 - Database Table for Jobs : S NQ JOB

10 - Database Table for Instances : S NQ INSTANCE
11 - Database Table for Parameters : S NQ JOB PARAM
12 - Database Table for Messages : S NQ ERR MSG

13 - DEFAULT VALUES

0 - Quit

k. Enter 5 and press Enter.
. Enter hdowner as your password and hdowner again to confirm the password.

The following information is displayed.
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**x*x%% Scheduler Database Configuration *****

- Database Type : Oracle 10g R1

- Call Interface : OCI 10g

- Data Source Name : RPTAPP

- User Name : hdowner

- Password : ***%%

- Timeout (Minutes) : 60

- Maximum Connections : 5

- Bulk Fetch Buffer Size (bytes) : 33792
Database Table for Jobs : S NQ JOB

10 - Database Table for Instances : S NQ INSTANCE
11 - Database Table for Parameters : S NQ JOB PARAM
12 - Database Table for Messages : S NQ ERR MSG
13 - DEFAULT VALUES

0 - Quit

O J o U w N

e
|

m. Enter 0 and press Enter.
n. Answer yes when prompted to save.

The following information is displayed.

***x*xx Scheduler Configuration *****
1 - Database

2 — General

3 - Advanced

0 - Quit

0. Enter 0 and press Enter.

The following information is displayed.

***x*x*x Delivers Configuration Menu *****
- Configure Scheduler

- Configure Mail

- Configure iBots

- Configure Workflow

- Configure Java Extension

- Quit

O U w N

p. Enter 0 and press Enter.

Go to the <OBIEE Install Dir>/server/Schema directory and login to the Fusion
Transportation Intelligence database via SQLPlus as HDOWNER.

Run the following command:
@SAJOBS.Oracle.sqgl

Exit SQLPlus when the script completes.

Restart all the Oracle Business Intelligence services. With this step, you have completed all the
configuration steps in OBIEE.
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Configuring Oracle Transportation Management for Oracle Fusion

Transportation Intelligence

Oracle Transportation Management Properties

After successfully installing and configuring OBIEE, please follow the instructions below to configure

the FTI related properties in OTM.

1. Open the file <OTM Install Dir>/glog/config/glog.properties.
2. Remove the # symbols and enter the appropriate values for the properties listed in the table

below:

Property Name

Description

OBIEE specific Properties

aa_ webserver

Use this to specify the complete URL of the OBIEE server
along with the port humber.

Example: aa_webserver =
http://myfti.mydomain.com:9704

Note: 9704 is the default port number if you are using OC4J
as the web application server for OBIEE. You may need to
change this port number.

Be sure to include the http:// or https:// as applicable

As Oracle Transportation Management does not pass through
the URL on an internal DNS name, you will need to open a
firewall IP and port so that Oracle Transportation
Management can call the external fully qualified domain
name (FQDN). After the changes are made, you will need to
restart the Oracle Transportation Management web server.

allow advanced analytics

Use this to enable/disable the FTI option in Oracle
Transportation Management. Use the values TRUE or FALSE.

Example: TRUE

glog.fti.dbserver

Use this to specify the host name of the database hosting the
FTI Historical database.

glog.fti.database.port

Use this to specify the Port number of the FTI Historical
database.

glog.database.fti.sid

Use this to specify the SID/Service name (as applicable) of
the database hosting the FTI Historical database.

glog.fti.database.schema

Use this to specify the name of the schema hosting the FTI
Historical database. This should typically be HDOWNER unless
a different schema name is used.

Example: HDOWNER
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http://myfti.mydomain.com:9704/

Property Name

Description

glog.database.fti.password

Use this to specify the password of the HDOWNER user in the
FTI Historical database.

Example: HDOWNER

glog.fti.connectstring

Use this to specify the database connection string for the FTI
Historical database.

ODI specific Properties

glog.odi.master.database.server

Use this to specify the host name of the database hosting the
ODI Master Repository.

glog.odi.master.database.port Use this to specify the port number of the database hosting
the ODI Master Repository.

glog.odi.master.database.sid Use this to specify the SID/Service name (as applicable) of
the database hosting the FTI Historical database.

glog.odi.master.database.password | Use this to specify the password of the FTIMASTER user in
the Database hosting the ODI Master Repository.
Example: FTIMASTER

glog.odi.agent.server Use this to specify the host name of the server that is
running the ODI Agent.

glog.odi.agent.port Use this to specify the port number on the server on which
the ODI agent is running.

glog.odi.password Use this to specify the password of the ODI login user.
Example: CHANGEME

glog.odi.work.repository.code Use this to specify the name of the FTI Work Repository

deployed in the ODI server.

Note: glog.odi.work.repository.code is the "Work
Repository Name” that we gave while creating the work
repository.

Example: FTI_WORK

Note: The values provided above are intended only as examples. See the Oracle
Transportation Management Online Help for additional information about these properties.

To facilitate looking-up of corresponding shipments in Oracle Transportation Management, FTI reports
support URL redirects on Shipment IDs. To build the URL, FTI uses the parameter OTM_WEB_SERVER
that can be configured in Oracle Transportation Management as described below:

1.

Log into Oracle Transportation Management as DBA.ADMIN.
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2. Navigate to Business Process Automation > Power Data > Document Generation >
Report Common Properties

3. Search for the property “"OTM_WEB_SERVER" and edit the default value (shipped as data
content) with the correct Oracle Transportation Management Host URL as below:

e http://<OTM Hostname>/GC3
For example, http://myhost.mydomain.com/GC3

4. Click Finish to complete the configuration change in Oracle Transportation Management.

5. For this configuration change to reflect in FTI, the ROD Refresh job (if an ROD is in use) must
be executed. If an ROD is not in use this step is not applicable.

6. Restart the OBIEE Services and then access the FTI Dashboard Reports.

Note: This configuration step must be done when configuring FTI for the first time to the
Oracle Transportation Management application or whenever the Oracle Transportation
Management application’s web server is modified.

Enabling Oracle Fusion Transportation Intelligence Agents in Oracle
Transportation Management

Loading an Object into Fusion Transportation Intelligence

By default, Oracle Transportation Management business objects are not loaded into Fusion
Transportation Intelligence when they are created. Oracle Transportation Management business
objects that can be loaded into Fusion Transportation Intelligence all have a status type of

##_ HD_LOAD_STATUS (for example, order base has a statue type of OB_HD_LOAD_STATUS). By
default, this status type is set to a value of OB_NOT_READY_TO_LOAD.

You must use an automation agent to change this status to OB_READY_TO_LOAD for the order base
to be loaded to Fusion Transportation Intelligence. Oracle Transportation Management ships with
several PUBLIC automation agents that allow you to load business objects to Fusion Transportation
Intelligence.

To enable the automation agents required to load Oracle Transportation Management business objects
into Fusion Transportation Intelligence, complete the following:

1. Log on to Oracle Transportation Management as DBA.ADMIN.

Go to Business Process Automation > Agents and Milestones > Automation Agent.
3. Search for and activate the following automation agents:

e LOAD_ORDER_BASE_TO_HD (Default Event: Order base created)

e LOAD_ORDER_RELEASE_TO_HD (Default Event: Order on shipment tendered)

e LOAD_SHIPMENT_TO_HD (Default Event: Shipment tendered)
4. Change the event if necessary.

Unloading an Object from Fusion Transportation Intelligence

When an object is deleted from Oracle Transportation Management, you may also want to remove it
from Fusion Transportation Intelligence. You can unload (soft delete) an Oracle Transportation
Management business object from Fusion Transportation Intelligence. To do this, you need to create
automation agents for the agent actions listed below:

e UNLOAD SHIPMENT FROM HD
e UNLOAD ORDER RELEASE FROM HD
e UNLOAD ORDER BASE FROM HD
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e UNLOAD SELL SHIPMENT FROM HD
e UNLOAD QUOTE FROM HD
e UNLOAD INVOICE FROM HD
e UNLOAD BULK PLAN FROM HD
e UNLOAD ORDER ITEM FROM HD
These automation agents can be set up similarly to the order release example below:

1. Select an Agent Type of ORDER RELEASE.

2. Select an Agent Event of ORDER - REMOVED with Restrictions of INTEGRATION, INTERNAL, or
USER. You do not need to select the Pre-persist option on the Restrictions page.

3. Add a single agent action of UNLOAD ORDER RELEASE FROM HD.

Mandatory Oracle Transportation Management User Role (VPD Profile)
Configuration

Identify the Oracle Fusion Transportation Intelligence users. Assign the appropriate Transportation
Intelligence Role to each user.

Oracle Fusion Transportation Intelligence offers additional external predicates in version 6.2. These
are now available under the following standard VPD Profiles shipped with the Oracle Transportation
Management application:

e FTI_DEFAULT: This VPD Profile is applicable for all Oracle Fusion Transportation Intelligence
users who are not service providers in Oracle Transportation Management. This includes all
the external predicates available in the existing DEFAULT Oracle Transportation Management
VPD profile and the new external predicates specific to the Oracle Fusion Transportation
Intelligence solution’s Historical Database tables.

e SERVPROV: This VPD Profile is applicable for all Oracle Fusion Transportation Intelligence
users who are also service providers in Oracle Transportation Management. This includes all
the external predicates available in the existing SERVPROV Oracle Transportation Management
VPD profile and the new external predicates specific to the Oracle Fusion Transportation
Intelligence solution’s Historical Database tables.

As a result, is it mandatory that you update the user role for all your existing Oracle Fusion
Transportation Intellitence users to include either the FTI_DEFAULT or SERVPROV VPD Profiles, as
applicable. Performing this manual step is mandatory to ensure the proper operational behavior of the
Oracle Fusion Transportation Intelligence application.

If you are using a customized VPD profile in Oracle Transportation Management, alternatively you
must manually include your additional external predicates over the FTI_DEFAULT or SERVPROV VPD
profiles as applicable.

Installing Other Languages for Oracle Fusion Transportation
Intelligence

Installing Other Languages for Oracle Fusion Transportation Intelligence
Metadata

Once you have received the other languages for Oracle Fusion Transportation Intelligence metadata,
follow the steps below to install them.
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Note : The other languages content for Oracle Fusion Transportation Intelligence metadata
will be shipped as csv files with the names w_localized string g <lang id>.csv
available under the directoy

<otm install path>/glog/oracle/script8/content advanced analytics

On the Oracle Transportation Management server, go to the directory
<otm install path>/glog/oracle/script8.

Load other languages for the Oracle Fusion Transportation Intelligence metadata data by
running update content_ aa. This process is run at the host command line rather than from
within SQL*Plus. Two command scripts are provided and the script you use is dependent on
your operating system:

UNIX shell script:

./update content aa.sh <otm install path>/glog/config
or

Windows command line script:
update content aa.cmd <otm install path>\glog\config

Review the log file called update content aa <timestamp>.log for errors (located in the
same directory as the SQL script). Look for errors by searching key words like "ORA-",
“Caught exception”,”SP2-", or “<Error>" within the log file.

Installing Other Languages for Oracle Fusion Transportation Intelligence Reports

Once you have received the other languages for Oracle Fusion Transportation Intelligence reports,
follow the steps below to install them.

Note: The other languages content for Oracle Fusion Transportation Intelligence reports
will be shipped as XML files available in language-specific folders under the directory
<otm_install path>/glog/oracle/script8/content advanced analytics.

1. On the OTM server, go to the directory
<otm_install path>/glog/oracle/script8/content advanced analytics.
2. Copy the below folders containing the other languages translation XMLs for Oracle Fusion
Transportation Intelligence reports,
e | _de
e |_en
e | es
e |_es-mx
o | fr
e | _fr-ca
o it
e |_ja
e | ko
e |_pt-br
e | ru
e | _zh-cn
e | _zh-tw
3. Now on the OBIEE server, stop the OBIEE services.
4. Now on the OBIEE server, start the OBIEE services.
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5. On the OBIEE server, place the copied folders (in Step 2) to the directory: <OBIEE Data
Dir>/web/catalog/res

6. Now on the OBIEE server, start the OBIEE services.

After successfully installing the languages for Oracle Fusion Transportation Intelligence, use the
Language preference under the User Preferences in Oracle Transportation Management to specify the
users preferred language.
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5. Database Administration

The contents of this chapter represent our recommendations rather than requirements. When making
any changes to an Oracle Transportation Management database, the DBA should always consider the
size and the activity pattern of the database, the hardware configurations, and business requirements.

Initial Setup of Oracle Database

Initial Parameters

Oracle Transportation Management provides a sample init.ora file with recommended values of some
key parameters. These values may need to be adjusted according to available physical memory on the
database server. As rule of thumb, the System Global Area (SGA), or the shared memory of a
database, should always be allocated in the physical memory for fast data access. If SGA is too large
and swapped to disk paging will occur. Paging usually overweighs the advantage of having a large
SGA. We recommend the following values for some of initial parameters.

DB BLOCK SIZE
8192 (or at least 4090)

DB 16K _CACHE-SIZE
104857600 (100 MB)

SHARED SERVERS
0

JOB_QUEUE PROCESS
4 (This is mandatory since Oracle Transportation Management database uses
scheduled jobs).

LOG_CHECKPOINT INTERVAL
Do not set this parameter if FAST START MTTR TARGET is set. Otherwise set it to
0 or infinity.

OPEN_CURSORS

1000

SESSION CACHED CURSORS
100

MEMORY TARGET = 8G

# MEMORY TARGET specifies the Oracle system-wide usable memory. The database
tunes memory to the MEMORY TARGET value, reducing or enlarging the SGA and PGA
as needed.

processes = 3000
# This number affect the number of connections to the database.
cursor_ sharing = FORCE

# Allows the creation of a new cursor if sharing an existing cursor, or if the
cursor plan is not optimal.

OPTIMIZER INDEX COST ADJ
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50
Setting this parameter to encourage optimizer to favor NESTED LOOP over HASH
JOIN.

OPTIMIZER INDEX CACHING

50

Setting this parameter to encourage optimizer to favor NESTED LOOP over HASH
JOIN.

statistics level = TYPICAL

query rewrite enabled
true
For using function based index.

query rewrite integrity
trusted
For using function based index.

Using Locally Managed Tablespaces

Oracle Database recommends using locally managed tablespaces for all of Oracle Transportation
Management tablespaces, including SYSTEM tablespace. Locally managed tablespaces can improve
performance by eliminating some recursive operations during space allocation.

Initial Redo Log Files

It is recommended to have three, four, or five redo log groups. Each group should have at least two
members. We recommend that the initial size of the redo log files be 10 - 20 MB. Once the database
is in normal operation, especially for a production database, the DBA should monitor the log switch
frequency. If log switch occurs too often; for example, less than 10 minutes, the size of redo log files
should be increased.

Initial Setting of Undo

Historically, Oracle Database has used rollback segments to manage undo. Space management for
these rollback segments has proved to be quite complex. In 9i and later, the Oracle Database provides
UNDO tablespace, another way to manage undoes, UNDO_MANAGEMENT=AUTO. Using this method
DBAs do not have to deal with the complexities of managing rollback segment space and can exert
control over how long undo is retained before being overwritten. This is the recommended method for
Oracle Transportation Management.

If you decide using manual UNDO management you should set up your rollback segments following
the guideline below. Rollback segments should be designed adequately to reduce contention and
prevent “snapshot too old” errors. Most of the transactions of an Oracle Transportation Management
database are small and of OLTP type. The number of rollback segments is determined by the number
of concurrent transactions in the database. For initial settings, the number of rollback segment should
be set to at least four. Each rollback segments also should have equal size of INITIAL and NEXT
extents with MINEXTENTS equals to ten. The INITIAL and NEXT extent size can be set to 2 MB. The
DBA should periodically monitor the rollback segment usage and adjust setting or add new segments,
if needed.
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Initial Setup of Oracle Transportation Management Database

There are several schema owners/users and database roles that need to be created in the database.
Running create_glog_users.sql will get these roles and users created. These two scripts should be run
by user SYS because there are EXECUTION privileges on SYS’s objects to be granted to Oracle
Transportation Management database users. Most of Oracle Transportation Management database
objects are under schema GLOGOWNER. Oracle Transportation Management database object types
include, but not limited to:

TABLE
TABLE PARTITION
INDEX
INDEX PARTITION
LOB
LOB SUBPARTITION
SEQUENCE
TRIGGER
VIEW
PACKAGE
PACKAGE BODY
PROCEDURE
FUNCTION
JAVA CLASS
JAVA SOURCE
QUEUE
TYPE

Each Oracle Transportation Management application table has a primary key. There are many foreign
keys in Oracle Transportation Management database to guarantee data integrity. Certain database
maintenance work such as import may cause foreign keys “NOT VALIDATED". The DBA should make
sure the status of the foreign keys are "ENABLED” and “VALIDATED".

Each application table also has a footprint trigger that populates footprint columns of the table. All of
the triggers should be "ENABLED".

Analyzing Tables/Gathering Statistics

It is very important that the Oracle Transportation Management database tables are analyzed
properly. Please refer to the section of the Administration Guide titled “"Analyzing Tables/Gathering
Statistics” for more details.

Real Application Clusters (RAC)

Oracle Transportation Management may be used in conjunction with Oracle Real Application Clusters.
Please refer to the section titled “Real Application Clusters (RAC)” in the Administration Guide for more
details on how to do that.
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